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Operating Instructions
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Read this manual carefully before you use this product and keep it handy
for future reference.
For safety, please follow the instructions in this manual.
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In accordance with ISO Standard 7001, this machine uses the following symbols for the
main switch:
| means POWER ON.

O means POWER OFF.

Recycled paper:
Please contact your sales or service representative for recommended recycled paper types
that may be used in this copier.

Two kinds of size notation are employed in this manual. With this machine refer to the inch
version.

For good copy quality, Ricoh recommends that you use genuine Ricoh toner.

Ricoh shall not be responsible for any damage or expense that may result from the use of parts
other than genuine Ricoh parts in your Ricoh office product.

Notes: Some illustrations may be slightly different from your machine.

Power Source: 120V, 60Hz, 13A
Please make sure to connect the power cord to a power source as above.
For details about power source, see page 80.

Copyright © 1998,1999 Ricoh Co., Ltd.

Note to users in the United States of America

Notice:

This equipment has been tested and found to comply with the limits for Class A digital devices ,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interface when the equipment is operated in a commercial
environment. This equipment generates, uses and can radiate radio frequency energy and ,if
not installed and used in accordance with the instruction manual, may cause harmful
interference to radio communications.

Operation of this equipment in a residential area is likely to cause harmful interference in which
case the user will be required to correct the interference at his own expense.

Warning:
Changes or modifications not expressly approved by the party responsible for compliance
could void the user’s authority to operate the equipment.

Note to users in Canada
Warning:
This Class A digital apparatus complies with Canadian ICES-003.

Remarque concernant les utilisateurs au Canada Avertissement:
Cet appareil numérique de la classe A est conforme a la norme NMB-003 du Canada.
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INTRODUCTION

This copier is a console plain paper copier carefully manufactured to exacting standards of high
performance. it consistently yields high contrast copies with a superior finish.

This manual contains detailed instructions on the operation and maintenance of this copier. To get
maximum versatility from this copier, all operators should carefully read and follow the instruc-
tions in this manual. Please keep this manual in a handy place near the copier.

Please read the next section before using this copier. It contains important information related to
USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

SAFETY INFORMATION

When using your machine, the following safety precautions should be always be followed.

Safety During Operation

In this manual, the following important symbols are used:

A\WARNING:

Ignoring this warning could cause serious injury or even death.
A\ CAUTION:

Ignoring this caution could cause injury or damage to property.

Examples Of Indications

fﬁ Symbol /\ mean a situation that requires you take care.

f} Symbol A\ mean “Hot surface”.

® Do NOT carry out the operation represented by this symbol S.

This example means “Do not take apart”.

Symbols @ mean you MUST perform this operation.
This example means ““You must remove the wall plug”.
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A\ WARNING:

N

Only connect the machine to the power source described on the
inside front cover of this manual.
Avoid multi-wiring.

e Do not damage, break or make any modifications to the power

cord. Do not place heavy objects on it, pull it hard or bend it more
than necessary. These actions could cause an electric shock or
fire.

Do not plug or unplug the power cord with your hands wet. Other-
wise, an electric shock might occur.

Make sure the wall outlet is near the machine and freely acces-
sible so that in event of an emergency it can be unplugged easily.

o
®

Do not remove any covers or screws other than those specified
in this manual. Some parts of the machine are at a high voltage
and could give you an electric shock. Also, if the machine has
laser systems, direct(or indirect)reflected eye contact with the
laser beam may cause serious eye damage. When the machine
needs to be checked, adjusted, or repaired, contact your service
representatives.

Do not take apart or attempt any modifications to this machine.
There is a risk of fire, electric shock, explosion or loss of sight. If
the machine has laser systems, there is a risk of serious eye dam-
age.

If the machine looks damaged or breaks down, smoke is coming
out, there is a strange smell or anything looks unusual, immedi-
ately turn off the operation and main power switches then unplug
the power cord from the wall. Do not continue using the machine
in this condition. Contact your service representative.

If metal, liquid, or foreign matter falls into the machine, turn off
the operation and main power switches, and unplug the main
power cord. Contact your service representative. Do not keep
using the machine with a fault or defect.

Do not put any metal objects or containers holding water(e.g.
vases, flowerpots, glasses) on the machine. If the contents fall
inside the machine, a fire or electric shock could occur.
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Toner dust might ignite when exposed to an open flame. Dispose
of the used toner cartridges according to local regulations for
plastics.

‘ e Do not incinerate used toner, toner bottles or toner cartridges.
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A CAUTION:

Keep the machine away from humidity and dust. A fire or an elec-
tric shock might occur.

Do not place the machine on an unstable or tilted surface. If it
topples over, it could cause injury.

After you move the machine, fix it with the caster fixture. Other-
wise, the machine might move or come down to cause a personal
injury.

When you move the machine, unplug the power cord from the
wall outlet to avoid fire or electric shock.

When the machine will not be used for a long time, unplug the
power cord.

When you pull out the plug from the socket, grip the plug to avoid
damaging the cord and causing fire or electric shock.

If you use the machine in a confined space, make sure there is a
continuous air turnover.

Do not reuse stapled paper. Do not use aluminium foil, carbon
containing paper or other conductive paper. Otherwise, a fire might
occur.

When removing misfed paper, do not touch the fusing section
because it could be very hot.

This machine has been tested for safety using this supplier’s parts
and consumables. We recommend you only use these specified
supplies.

Do not eat or swallow toner.
Keep toner(used or unused) and toner cartridges out of reach of
children.

>BPPO0eR A& ©

This equipment is only to be installed by a qualified service per-
sonnel.
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VAN

e Deliver to collection point for waste products. Do not be disposed
of via domestic refuse collection.
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Vi

HOW TO READ THIS MANUAL

Symbols

In this manual, the following symbols are used:

/\ WARNING:

This symbol indicates a potentially hazardous situation that might result in death or serious injury
when you misuse the machine without following the instructions under this symbol. Be sure to
read the instructions, all of which are described in the Safety Information section.

A\ CAUTION:

This symbol indicates a potentially hazardous situation that might result in minor or moderate
injury or property damage that does not involve personal injury when you misuse the machine
without following the instructions under this symbol. Be sure to read the instructions, all of
which are described in the Safety Information section.

* The statements above are notes for your safety.
1k Important

If this instruction is not followed, paper might be misfed, originals might be damaged, or data
might be lost. Be sure to read this.

& Preparation
This symbol indicates the prior knowledge or preparations required before operating.

@ Note

This symbol indicates precautions for operation, or action to take after misoperation.

® Limitation
This symbol indicates numerical limits, functions that cannot be used together, or conditions in
which a particular function cannot be used.

A Reference
This symbol indicates a reference.

(]

Keys built into the machine’s operation panel.
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WHATYOU CAN DO
WITH THIS MACHIN

E (FW7030D MAIN UNIT)

Auto Paper Select

= Page 21 (

Select Roll Length

e Synchro Cut = Page 23
¢ Preset Cut/ Variable = Page 24

User Tools
@ Check Display .
® Fusing
[ ] i Temperature
Program
*d

m’aper-based Reduce/ Enlarge]\ (

= Page 22 \ O Synchro ﬁ\ OFull Size D
O Preset / O o Paper

N

RRR- R}

\ ~/
K[Preset Reduce/Enlarge ] \

O Interrupt
Memory
Oc
Variable O Auto Reduce/ - oy
Enlarge Leading Ed Shift )
m ige ift Image
> 1 jlorg O presetReducel Trailing OonLine
nlarge
2219 | 5700m D
» 3T [ [ O Direct.Mag Clar s/
06 Onergy Saver

/@

Copy Medi Image Densit
opy Media | tmage Density [ 1 H\Z H 3 ] reiew Gomy
O Vellum OOrngmaI D OPhoto [@
OFilm OLight O AutoImage
oﬂgmal Density 4 l 5 ] 6 Roll Edge Cut

Image Edit
e o o m o o o

Gadiaadd [z E o)

Emergency Stop

QO Erase Border

O Mirror |'"599D Lighter] Darker Cleax/Stop @
Positive/ N

Ot (o Jlce

= Page 29
R \

R <

\ )
( [zoom] )

= Page 31

\
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\ /

Adjust Image Density

= Page 19

Select Original Type

= Page 19

Fusing Temperature

= Page 25

[ Directional Magnification ]
= Page 32

Erase Border = Page 33

Mirror = Page 34
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Horizontal
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Image Shift ( Lead )

—
—
= Page 26
D Interrupt ) = Page 1
(Memory Unit required.)
Memory
D Copy
— )
—
D On Line
)
Gy
D = Page 11
w Copy (Memory Unit required.)
ige Cut \
ncy Stop
] I
— \_
S—
—_—

Preview Copy

= Page 39

R-:»

Image Shift ( Trail )

R-=>

Image Shift ( Left )

R -R

Image Shift ( Right )

R-RH

K = Page 35 \

Leading edge margin ( +)

R

=

Leading edge margm (-)

R

Trailing edge margin (+)

R

=

R

Positive / Negative = Page 34

R-=

Xi
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Xii

OPTIONAL MEMORY UNIT

If you attach the Memory Unit Type 7030D option to the main unit, the extra functions described

below become available.

Note that when making copies with the Memory Copy feature, the machine scans in the image using
either 2 or 4 gradations (Normal or Fine). This is as opposed to standard copying, where 32
gradations are used. Therefore, you should use standard copying when you want to clearly copy

originals containing small numerals or characters, fine graphics or photographs.

To program images into memory and recall them, the HDD is required. If you need the HDD, please
consult your sales or service representatives.

® Check Display

1

.o

Osynehro D OFullsize
Orssat] O hoPar
Varable ober

-1 ot rsia!
O

2 Ozoom D
>3 Oty
I

image Edt

O age

o | I T JL o Jlee])

D

Olmtermupt
¥

e
olemory

OOnLine

B

og:{;n,ﬂ Onato D

OFiim oLight opems )| (4 ][5 (6] morcamon
@

[Memory Copy] key

If you wish to make multiple copy sets of multiple page originals, Memory Copy gives you control
over how the copy sets are delivered. Before you start copying, specify the number of copy sets and
delivery method (Stack or Sort). When you use this feature, the original is scanned in once, and

multiple copies are made from memory.

Stack
Scan
the originals

Memory

1
A/Make copies

3 I [
IS ) .S |

[Interrupt] key
If you wish to make a few copies but there is a
long copy job in progress, press this key to tem-
porarily stop the job. Then make your copies
and press the [ Interrupt ] key to recall the previ-

ous copy settings.

Sort

Scan

the originals
—

Memory

Ake copies

1 1
2 2
! 3 L ! 3
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GUIDETO COMPONENTS

Carrier sheet guides

(left and right) Copy guides Original cover
Extend these guides (left and right) o

when using the optional Original reverse
carrier sheet. If youare guide

not using a carrier sheet, Guides copies so that
you can use them to are delivered towards
hold aroll original when you.

feeding itin.

Original table Upper rear cover

Set originals here. f"’"\rﬁ =
= § —~ ===
———— — ‘ﬁ
==\

Operation panel

Original guide
(left)

Right side cover

D

i)

il
1] |

Power switch

Set this switch to “I” to
turn on the power.

Set this switch to “0”
to turn off the power.

Note that the copier

Manual copy guides

|

Front cover sl
<]
\D

Copy catch tray

Copied paper is deliv- turns itself off auto-
ered here. matically if nobody
uses it for a certain pe-

Manual feed table riod of time.

Insert paper here to feed it manually. You also £ Reference
use this tray when copying onto non-standard “Auto Off Timer” =>
size paper or film. B

Page 71
A Reference .
“COPYING ONTO PAPER SET ON THE
MANUAL FEED TABLE” => Page 16
Ventilation grill
Prevents overheating. i \. ——— %E'ﬁ
Do not obstruct the :’ m [
ventilation grill by plac- <\ o Y ||IIIIIHH 9
ing or leaning an ob- ]
ject near it. If the ma- I il
3 c i
chine overheats, a fault m
might occur. ca ° rlf
; . ‘
\CL6A9106m/ CE7A0100
S~ V4 ® 11 J

Xiii

*
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OPTIONS

Ricoh Roll Feeder Type 7030D
You can add an extra roll feeder. It is of the
same type as the second standard roll feeder.

CEO0A0201

Ricoh Memory Unit Type 7030D

Allows you to use the sort/stack function. This
option also prevents originals from being dam-
aged when making multiple copies or using the
Auto Image Density function.

o

: o

CE8A0101

Xiv
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OPERATION PANEL

Screen (panel display)
Shows operation status, error
messages, and function menus.

User Tools

o Fusing
m

Tomperature

[A)(V] keys
Press to adjust setting values or select func-
tions.

— [User Tools] key

Press to access the User Tools where you
can customize the default settings to meet
your requirements.

=> Page 79, “ACCESSING THE USER
TOOLS OVERVIEW”

’f[lnterrupt] key

Press to make interrupt copies during a copy

—These indicators show er-
rors and the machine sta-
tus.

Page 41, “WHAT TO DO
IF SOMETHING GOES
WRONG”

[ Check Display]
See the panel display.

[Number] keys
Use to enter numbers such as the number of
copies or a reproduction ratio.

s [ o .| o= run (The Memory Unit is required).
opmsey L [ ot ey
i . (Memory Copy] key

rg Preset Reduce/ On Line . . .. .
o | e oten D Eﬂ ° Having multiple page originals scanned into
>3 | Opgess ot o memory first gives you control over how
T e T— G2 B | reterce copy sets are delivered with the Stack and
o D :"z..D Oa:':,';'g'D EEED) d!_w ey Sort features (The Memory Unit is required).
Image Edit P —— [cid
ST“::"D e Il Jjig= [#] key
Ofestel o Jice Use this key to enter values confirm set-

tings.

[Clear Modes/Energy Saver] key
Press to clear any previously entered copy
job settings. When you hold down this key
for three seconds or more, the copier enters
Energy Saver mode to conserve power.
Press this key again to exit Energy Saver
mode.

L—[Cut Leading Edge] key
Cuts the leading edge of the roll paper.

[Emergency Stop] key
Stops originals being fed.

[Clear/Stop] key

Clear Press to cancel a number you have
entered. Stop Press to stop/cancel copying.
During a memory copy run, this key has
the following functions: Clear While enter-
ing the number of copies, press to cancel a
number you have enteres. Stop Press to
stop a memory copy run and return to the
previous operation.

XV
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ORIGINALS

Sizes and Weights of Recommended Originals

Where original is set Original size Original weight

Original table E (36" x48")-A (9" x 12") 64 - 150 g/m?
Length: 11" - 197" (17.0-39.9 1b)
Width: 8.5" - 36"

O When making multiple copies, the original length must be between 11" and 48"

Originals that Require the Carrier Sheet

Use the carrier sheet when copying types of originals described below. You should also use it

when copying originals you want to handle carefully or originals you use repeatedly.
 Originals that have low stiffness or thin originals

* Carbon paper

* Creased or folded originals

* Punched or perforated originals

* Pasted originals

/O Reference

“Using the Carrier Sheet” => Page 15
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BASICS

Non-recommended Originals for the Original Table

O Setting the following originals on the original table might cause paper misfeeds or damage to
the originals:
* Originals other than those specified in “Sizes and Weights of Recommended Originals”
* Stapled or clipped originals
* Perforated or torn originals
 Bent, folded, or creased originals
* Pasted originals
* Originals with any kind of coating, such as thermal fax paper, art paper, aluminum foil,
carbon paper, or conductive paper
* Originals with indexes, tags, or other projecting parts
 Thin originals that have low stiffness, such as registers
e Originals of inappropriate weight, such as postcards
* Bound originals such as books
e Damp originals
* Curled originals
e Originals that have parts of different weight
* Originals with adhesive tapes or paste
0 When you make multiple copies of a translucent original written with a pencil, the original
might be smudged with pencil dust. When you making multiple copies of such an original,
make a copy on bond paper and use it as the original to make the necessary number of copies.
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ORIGINALS

Original and Paper Sizes That Can Be Read Automatically

O The machine can only automatically detect the width of originals and copy paper. For origi-
nals, the position of the left original guide is used to detect this width, so make sure that the
guide position matches the size of your original. For copy paper, the machine automatically
recognizes the width of roll paper set as one of Engineering or Architecture type sizes.

O Depending on whether the size mode setting is set to Engineering sizes or Architecture sizes,
the original and copy paper widths that can be read differ as shown in the table below. => Page

71, “Size mode setting”

Original width Engineering 17.0" 22.0" 34.0"
Architecture 18.0" 24.0" 36.0"

Paper width Engineering 17.0" 22.0" 34.0"
Architecture 18.0" 24.0" 36.0"

Scanning Area

l0~0.4"

e T _ . N.0~0.16" o
Q
=1
o
)
@
Q
=3
@
=3
Z

i =}
10~0.4"
(except for cat errors)

O The machine does not copy a small bounding margin around all four sides of originals as
shown in the illustration above (dimensions when using roll paper and full-size copying).
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BASICS

COPY PAPER

Recommended Paper Sizes and Types

O The following table shows the sizes and types of copy paper that you can load in this copier:

Translucent Paper (Vellum)

Film

Tray type Recommended paper type Recommended paper size Number of sheets
that can be set
Paper tray Bond paper Roll paper diameter: 7.1" or less
64 - 80 g/m?(17.0 - 21.3 1b) Internal diameter: 3.0" +/- 0.04" o
Translucent Paper (Vellum) Width: 420 - 920 mm
Film
Manual feed | Bond paper E(36"x48" [[J D (24" x 36"
table 64 - 80 g/m? (17.0-21.31b) | C(18"x24" B (12" x 18")

D©O"x12") [}
Paper width: 8.3" - 34.6"
Paper length: 11.7" - 78.7"

Copying onto Translucent Paper or Film

O After each copy is delivered to the copy catch tray, remove it and place on a flat surface.

Roll Paper

3 If roll paper is damp due to high humidity, cut off a length of about 40" immediately before

copying.
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Non-recommended Paper

A\ CAUTION:

® e Do not reuse stapled paper. Do not use aluminum foil, carbon-

containing paper, or other conductive paper. Otherwise, a fire
might occur.

Do not use the following types of paper because a paper misfeed might occur:

aaa

* Bent, folded, or creased paper » Torn paper

» Perforated paper * Rough paper

 Slippery paper * Thin paper that has low stiffness
* Released paper e OHP sheets

If you make a copy on rough grain paper, the copy image might be blurred.

If you use curled paper, you might not be able to make clear copies.

If you copy onto paper types other than those specified in this manual (in particular, Japanese
chemical paper, saddle paper, or thin film), a paper misfeed might occur and the copy image
might appear faulty or wrinkled.

Do not use copy paper with any kind of coating, such as thermal fax paper, art paper, alumi-
num foil, carbon paper, or conductive paper. Otherwise, a fault might occur.

Do not reuse paper that has been already copied on by another machine.

Paper Storage

a

O

When storing paper, the following precautions should always be followed:

* Store paper in a location free from direct sunlight.

* Store paper in a location with humidity of 70 % or less.

* Store on a flat surface.

Once you take paper out of the container it was supplied in, store it in a vinyl bag to keep it
away from humidity.
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Handling Copy Paper

O Check the following table for advice on handling copy paper based upon how humid your

locale is.

% State of copies Try this...

Low humidity | Part of the copy image is lost or a| -Improve the environment where the copier is
multi-sheet feed or wrinkling oc-| placed (e.g., install an air conditioner or humidifi-
curs both on translucent paper and | er).
normal paper. -Remove paper from the copier immediately after

copying, and store it in a vinyl bag.
Part of the copy image is lost on| - When you do not use the copier for a long time,
translucent paper. remove translucent paper from the copier and
store it in a vinyl bag.
40 - Store paper in a vinyl bag when you have finished
(Normal conditions) copying every day.
70 Part of the copy image is lost both | - When you do not use the copier for a long time,
on translucent paper and normal pa- | remove paper from the copier and store it in a vi-
per. nyl bag.
Part of the copy image is lost or a| -Improve the environment where the copier is
muliti-sheet feed or wrinkling oc-| placed (e.g., install an air conditioner or dehumid-
curs both on translucent paper and | ifier).
normal paper. -Remove paper from the copier immediately after
High humidity copying, and store it in a vinyl bag.

Anti-humidity Heater

The copier paper tray has an Anti-humidity Heater.

more, or when the temperature changes suddenly.

1k Important

Turn on this heater when humidity is 70 % or

O Turn off the Anti-humidity Heater in cases other than the above.
O Turn off the Anti-humidity Heater when using translucent paper or film.

@ Note

O You can turn on the Anti-humidity Heater even when the copier is turned off.

Loading Copy Paper

/O Reference

“IF COPY PAPER RUNS OUT” => Page 48
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Handling Toner

/\ WARNING:

e Do not incinerate toner or toner containers. When exposed to
open flames, toner dust might ignite causing a burn.

Dispose of the used toner container according to local regula-
tions.

A\ CAUTION:
f ¢ Keep toner (including used one) and toner containers out of reach

of children.

Toner Types : Ricoh Toner Type 1100W
A\ CAUTION:
f e This machine has been tested for safety using this supplier’s parts

and consumables. We recommend you only use these specified

supplies. @

O If you use toner other than that recommended, a fault might occur.

Toner Storage

O When storing toner, the following precautions should always be followed:
 Store toner containers in a cool, dry place free from direct sunlight.
* Do not store toner where it will be exposed to fire.
» Keep toner out of reach of children.
* Store on a flat surface.

If the waste toner tank full

O When “Check waste toner tank” is displayed, see Page 51.

@ Note

[ Used toner cannot be used.

Adding Toner

/O Reference
“IF TONER RUNS OUT” => Page 53
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SETTING UP THE MACHINE

Attaching the Original Reverse
Guide

[l Attach the original reverse guide to the
top on the rear side of the machine.

@ Note

3 Open the copy catch tray before setting the
support boards.

O You can set the support boards in one of
five positions.

O When setting the support boards, see the
label describing the procedure. If copied
paper is not delivered to the tray properly,
shift the support boards upward or down-
ward.

CIE1 GOZOIO

@ Note

O Remove the original reverse guide when
making multiple copies, using Auto Image
Density, using Pre-scan or when originals
are delivered from the front of the copier.

Attaching the Copy Catch Tray
Support Boards

i] Change the support board positions de-
pending on the length of copies.

(')E3P0100

Opening the Copy Guides

[I Open the copy guides on both sides when
copying onto E (36'' x 48", length: 48'")
or larger paper.

& Note
O Be sure to close the copy guides except
when copying onto E (36" x 48") or larger

paper.
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BASIC COPYNIG

When you set your original, the machine scans
it in and copies it. If you specified more than
one copy, the machine repeatedly scans the
original for every copy made.

i] Press the [ Clear Modes/Energy Saver ]
key if any previous copy settings remain.

x4

= M
OCopy

O0n Line

O Nodes/
Eney Saver

/G
T2 )3 ] rewmom

A )5 J{6 ) e
7 s o | =

ORight

CE2A0117

E Make sure that the Memory Copy indi-
cator is not lit and the message ‘“Ready”
is shown on the panel display.

Ready 1
100.0% 34.0"x17.0"

B Select any copy functions you require.

»° Reference

For more information on functions that are
available, check the table of contents on
page xx.

[I Enter the number of copies you wish to
make with the [ Number] keys.

el
e @E@ o

lm Image D Roll Edge Cut
[Ca
pai ' e Il g™

prker Clear/Stop

(o Jlce]

J

J

CE2A0102

*

® Limitation
3 You can make up to 20 copies.

@ Note

3 If you enter the wrong number, press the
[Clear/Stop] key then try again.

B Load copy paper or select Paper Tray 1
or 2.

E Set your original.
The machine starts copying.

*3* Important

3 Do not open the front cover during a copy
run.

A Reference
“SETTING ORIGINALS” => Page 14

@ Note

O To stop originals being fed right away, press
the [Emergency Stop] key.The machine
will immediately stop feeding the current
original. This might result in a paper jam,
so see “TF COPY PAPER OR AN ORIGI-
NAL IS MISFED” ( => Page 56) for how
to remove the jammed original.

O To stop the current copy run, press the
[Clear/Stop] key. The machine finishes
copying the current copy and stops.

O The maximum number of copies that can
be received in the copy catch tray is 15 for
E (36" x 48") paper, 20 for D (24" x 36")
paper, or 1 for paper of other sizes.

ﬂ The original is delivered.
Originals are delivered from the original
delivery slot on the back of the machine.
Copied paper is delivered from the copy
delivery slot and received in the copy catch
tray.

Tips

O You can change the initial settings for ba-
sic functions. => Page 69, “Initial Setting”
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O The machine returns to its initial condition
automatically if you do not operate it for a
certain period of time after your copy job
is finished. This function is called “Auto
Reset.”

* To change the Auto Reset time:
=> Page 71, “Auto Reset Time”

O The machine turns itself off automatically
if it is not in use for a certain period of time
(30 minutes by default) after your copy job
is finished. This function is called “Auto
Off”
¢ To change the Auto Off time:
=> Page 71, “Auto Off Timer”

Memory Copy (Memory
Unit Required)

This function stores several originals (one
original for copying with manual feed) in
memory before making the necessary num-
ber of copies.

& Preparation

O The Memory Unit Type 7030D contains
16 MB of memory as standard. You can
extend this memory to a maximum of 64
MB. You can also add an HDD to the
Memory Unit. For more information, con-
tact your sales or service representative.

O The number of originals that you can store
in memory at a time differs depending on
the available memory space in the Memory
Unit, and the original size and image.

O When you add extended memory to the
copier, the Memory Copy is selected by
default when you power on. To change this
setting, see “Memory copy mode” on page
72.

3 You should set the image quality level to
“Normal” or “Fine” and the copy delivery
method to “Stack” or “Sort” before start-
ing a memory copy run.

Select “Normal” when you store ordinary
originals in memory. Select “Fine” when
you store originals containing small char-
acters or numbers, fine graphics, photo-
graphs, or maps.

Stack

LI
I

@ Limitation

O You cannot select “Dark Original/Light
Original” or “Photo” with the Memory
Copy function.

O During a memory copy run, originals are
delivered from the original delivery slot on
the back of the machine.

Stack/Sort

@ Limitation

O When copying with manual feed, you can-
not use the Stack/Sort function since it is
not possible to store several originals in
memory. => Page 17, “Copying Onto Pa-
per Set On The Manual Feed Table
(Memory Copy)”

O You can adjust the Copy Image Density
(Lighter/Darker) for each original to be
stored. However, can only specify the pa-
per type, reproduction ratio, and other set-
tings once before scanning the first
original. When you select Auto Reduce/
Enlarge, you can change the reproduction
ratio by fitting the left original guide to an
original size when you set the original (the
reproduction ratio is not displayed while
scanning the original).

11
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i] Press the [ Clear Modes/Energy Saver ]
key if any previous copy settings remain.

E Make sure that the Memory Copy indi-

cator is lit.
If it is not lit, press the [Memory Copy]
key.
Ready(NormaleStack) 1
100.0% 34.0" x 17.0"

B You can set the image quality level to
“Normal” or “Fine” and the copy deliv-
ery method to “Stack” or “Sort.’

A Reference
=> Page 74, “Copy quality setting” Page
75, “Output Setting”

[I Enter the number of copies required
with the [Number] keys.

? Limitation
O You can make up to 20 copies.

@ Note

O If you enter a wrong number, press the
[ Clear/Stop ] key and enter the correct one.

H Select a paper type.
Selecting a Paper Type
There are three ways to select the paper type:
 Select a paper tray.
e Select “Auto Paper Select.”
* Select “Auto Reduce/Enlarge” and
choose a paper tray.

E Specify any other functions you require,
such as the reproduction ratio, margins,
editing etc.

12

ﬂ Select [ Auto Image Density], and use
the [Lighter J/[ Darker) key as neces-
sary.

@ Note

0 When you select [ Auto Image Density ],
the copier scans part of the original in or-
der to calculate the image density, then
scans the entire original again. When scan-
ning several originals, you can have this
operation performed only for the first origi-
nal. => Page 69, “Image Density”

8 Feed your original face down along the
original guide.
The copier starts scanning.

° [

>
/
-y

"
CE1C0200
l 118y

Now scanning

Please wait
Ready to set original

g Feed the next original along the original
guide (you can use the [ Lighter)/
[Darker] key before this operation).
Repeat this step to scan all originals you
want to store in memory.

Insert next original 1-5
Last orig. -> #
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& Note
O Numbers shown on the upper right corner
of the screen represent the following:

1-5 | Numberontheleft Number of originals
Number on the right Number of copies

O The remaining memory space is displayed
on the lower right corner of the screen if it
reaches 64 MB or less.

m When you have finished scanning the
originals, press the [#] key.

m To start copying, press the [#] key again.

Press # for copying 3-5

@ Note

O If you want to change the copy quantity,
press the [ Clear/Stop ] key. Then press the
[Clear/Stop] key again and enter a new
quantity with the [Number] keys. To re-
turn to the previous screen, press the [#)
key.

Memory copying

m When the copier completes copying, the
following message appears on the panel
display:

Ready(NormaleStack)

& Note

O When using the Sort function, the maxi-
mum number of copies that can be received
in the copy catch tray is 15 for E (36" x
48") paper or 20 for D (24" x 36") paper.
When copying onto paper of other sizes,

take copies one by one out of the copy catch
tray.

m To copy the originals stored in memory
again, press the [#] key then return to
step 4.

© Enter the number of copies required with
the [Number] keys.

A Press the [#] key.

The copier starts copying.

IIITO clear memory, press the [ Clear
Modes/Energy Saver] key.
The copier clears memory and returns
to the ready condition for Memory Copy.

13
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SETTING ORIGINALS

A Reference

For information on originals, see “ORIGI-

NALS.” => Page 1

@ Note

O Set originals after correction fluid or ink
has completely dried. Not taking this pre-
caution could mark the exposure glass and
cause marks to be copied.

i] Set your original face down while align-
ing it to the reference mark, and fit the
left original guide to the original width.

@ Note

O Be sure to fit the left and right original
guides to the original width to prevent the
original from being fed at a slant.

O Slide the original guides so that the inside
of the transparent part fits the original.

Original guide

Size indicator

Transparent part 4@7!

g Make sure that the message ‘“Ready” is
shown on the panel display.

Ready 1
100.0% 34.0"x 17.0"

@ Note

O The green arrow lights when the copier en-
ters the ready condition. When this arrow
blinks, you can use the Auto Start func-
tion.
=> Page 27, “Auto Start”

B Feed the original face down along the
original guide.
The copier starts copying.

>

: il

J

a
CE1C0200
l 11B)

@ Note

O Release the original when the machine
pulls it slightly into the machine.

O If the original is at a slant, pull it out and
feed it in straight.

O If you wish to stop copying after the origi-
nal has started to be fed, press the [ Emer-
gency Stop] key and remove the original
from the copier.

O When copying a long original, prevent the
leading portion of the delivered original
from coming back into the original feed
slot.
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Using the Carrier Sheet

B Extend the carrier sheet guides.

A~ Reference

For original types you should copy with the
optional carrier sheet, see “Originals that Re-
quire the Carrier Sheet.” => Page 1

@ Note

O When you make copies using the carrier
sheet and [Synchro Cut], they are cut to
the carrier sheet length.

1k Important

O When using the carrier sheet, specify “1”
for the number of copies (when the
Memory Unit is not attached). If you make
multiple copies with a carrier sheet, origi-
nals might be damaged.

O You can use the carrier sheet only when
originals are delivered from the original de-
livery slot on the back of the machine. If
originals are delivered from the front of the
machine, they might be damaged.

i] Open the carrier sheet with the trans-
parent side facing up, and insert your
original face up.

MA9F0100

@ Note

O Align the original to the folded portion of
the carrier sheet.

»fk _
=y 12
N[ o))

B Insert the folded portion of the carrier
sheet into the original feed slot.

@ Note

O Set the carrier sheet with the original face
down.

O Release your hands from the carrier sheet
when it is pulled slightly into the machine.

O if the carrier sheet is fed at a slant, pull it
out and feed it in straight.

O If you wish to stop copying after the origi-
nal has started to be fed, press the [ Emer-
gency Stop] key and remove the original
from the copier.

15
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COPYING ONTO PAPER SET
ON THE MANUAL FEED TABLE

This function allows you to copy onto paper
of sizes that cannot be handled by the paper
tray, as well as A (9" x 12") or other cut sheet
paper.
This section describes the procedure you fol-
low when the Memory Unit is not installed.
A Reference
For recommended paper types, orientations,
and capacity of the manual feed table, see
“COPY PAPER.” => Page 4
? Limitation
O When copying with manual feed, you can-
not use the following functions:
* Erase Border
* Margins

i] Press the key shown to turn off all of 11}
to 319,
The message “Bypass” is shown on the
panel display.

-
O Synchro D OFull Size o+ D Oup
OPreset/ O fo baper o— ODown
Variable O Auto Rediuce!

Enlarge Leading )

1 Preset Reduce/ Trailing Edge | Shiftim
© Enlarge

> 215 Ozoom D o+ OlLeft
>3 O:‘)yidm.llag. o= ORight
Copy Media | Image Density I’ 1 I r
oveum [] ] 0Bk )| ophoto [ | CE2A0108]

Add paper 1
100% Bypass

E Select any special functions that you re-
quire.

A Reference
For more information on functions that are
available, check the table of contents on
page xx.

B Insert the paper into the manual paper
feed slot while aligning it to the size in-
dicator on the manual feed table.

@ Note

O Set the paper with the side you wish to copy
face-down.

O Release the paper when the machine pulls
it slightly into the machine.

O If the paper is fed at a slant, pull it out and
feed it in straight.

E] Set your original.
The copier starts copying.

1k Important

O If the copy curls when it is delivered, it
might enter into the manual paper feed slot
again and cause a paper misfeed. Prevent
the copy from coming back into the manual
paper feed slot.
When a copy is fed out, remove it by hold-
ing its edge with both hands.

@ Note

O You can set either an original or copy pa-
per first.
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Memory Copying Onto
Paper Set On

The Manual Feed Table
(Memory Unit Required)

? Limitation

0 When setting paper on the manual feed
table using the Memory Copy feature, you
can only store a single original.

O You must set your original and scan it in
before you set the copy paper in the manual
feed table.

i] Press the [ Clear Modes/Energy Saver )
key if any previous copy settings remain.

E Make sure that the Memory Copy indi-
cator is lit.
If it is not lit, press the [Memory Copy]
key.

Ready (NormaleStack)

B You can set the image quality level to
“Normal” or “Fine.”

A Reference
=> Page 74, “Copy quality setting”

[I Press the key shown to turn off indica-
tors 1185 to 319i.
The [Check Display] indicator lights
prompting you to set your original. The
following message appears on the panel
display:

Set original/paper 1
100% Bypass

B Specify a reproduction ratio, editing, or
any other functions you require. Select
[Auto Image Density], and use the
[Lighter Y[ Darker] key as necessary.

B Set your original.

Now scanning

Plese wait

Add paper 1
Bypass

ﬂ Insert copy paper into the manual pa-
per feed slot while aligning it to the size
indicator on the manual feed table.

The copier starts copying.

Memory copying

Bypass

@ Note

O Release the paper when the machine pulls
it slightly into the machine.

O If the paper is fed at a slant, pull it out and
feed it in straight.

Set original/paper

B Set the next paper.

gWhen you have made the necessary
number of copies, press the [ Clear
Modes/Energy Saver] key.
The copier clears memory and returns to
the ready condition for Memory Copy.

17
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ADJUSTING COPY IMAGE DENSITY

F] Preparation

O You can adjust the copy image density in
five ways:
[ Auto Image Density )
Scans originals based on their image den-
sity, allowing you to copy originals with a
dark background, such as newspapers.
[ Darker/Lighter ]
Allows you to specify 13 levels of image
density manually.
[Dark Original]
Specify this option when copying dark
originals.
[Light Original ]
Specify this option when copying light
originals.
[Photo]
Clearly reproduces halftone images such
as photographs.

@ Note

O By default, [ Auto Image Density ] is lit for
the copy image density adjustment. You
can change this setting. => Page 69, “Im-
age Density”

O By default, [Lighter] is selected for the
background image density. You can change
this setting. => Page 65, “Setting back-
ground Image Density”

3 You cannot select [ Dark Original }/[ Light
Original ] or [Photo] while the [ Memory
Copy ] indicator is lit.

Auto Image Density

[I Press the key shown to turn on the [ Auto
Image Density ] indicator.

o
OZoom

> 21 D o+ D Oleft
>3 OE.};,"""“" o= ORight
Copy Media | Image Density E][

Dark
OVeIIumU ooﬁgi"a,[l OPhoto D
OFilm OLight OMuto Image

bt U | gL | (4]
Image Edit

(]. e o m o o .'
O Bortr EEEEEEN [
O Mirror Image, Lighter Darker
_——

I

CE2A0103 7]

@ Note

3 If you do not wish to select any other func-
tions, set your original and start copying.

O The copier scans a portion of the original
to calculate the appropriate image density,
then copies the entire original. Do not hold
down or pull out the original while it is
moving to and fro.

O You can also use the [ Darker] or [ Lighter]
key to adjust the copy image density more
subtly when [Auto Image Density] is se-
lected.

® Limitation
O You cannot select [ Dark Original }/[ Light

Original ] while the [ Auto Image Density ]
indicator is lit.
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Darker/Lighter

Dark Original/Light Original

i] Press the key shown to turn off the [ Auto
Image Density] indicator.

v
OZoom D
O Direct.Mag.

)
| Image Density

Dark
O Original
OLight

Original

> 21
>3

OlLeft

gt D ORight

O Photo [Z] [
O;:W*D (a1l

(amwummnud [
(|

CE2A0126 ™|

Copy Media

O Vellum
OFilm

Image Edit

OFrase Border

OMiror mage
Positive/

OnNegative

E Press the [ Darker] or [ Lighter] key to
select an image density level.
The image density indicator shows the
level.

»>215 D Oleft
>3

Copy Media
O Vellum
OFilm

Image Edit

-
OZzoom D o+ D
O Direct.Mag. —_— i

B o ORight
| Image Density [ : ] [
EDak D OPhoto D

Original
OlLight O Auto Imag

it el | (4[]

Original

(amwmmnud [
Lighter Darker
C_ 0

CE2A0105 |

OFrase Border
OMMiror image|
(o]

Positive/
Negative

@ Note

O If you do not wish to select any other func-
tions, set your original and start copying.

O When two image density indicators are lit,
the selected density is half way between
these two levels.

[I Press the key shown to turn off the [ Auto
Image Density] indicator.

g Press the key shown to turn on the [ Dark
Original ] or [ Light Original )] indicator.
Ozoom o+
Omad.mg.[:] O = D
| Image Density

Dark
O Original
OLight

Original

> 21
> 31

Oleft
ORigh

Copy Media

O Vellum
OFilm

Image Edit

O Photo
O Auto Ima
Density o

O Erase Border Gl EEEERN l'

OMiror image
Positive/
ONegative

Lighter Darker

|
(a_]f
i
e

CE2A0106

@ Note

O3 If you do not wish to select any other func-
tions, set your original and start copying.

O You can use the [ Darker ] or [ Lighter ] key
to adjust the copy image density more sub-
tly when [ Dark Original) or [ Light Origi-
nal] is selected

® Limitation

O You cannot select [ Dark Original }/{ Light
Original ] while the [Memory Copy] in-
dicator is lit.

19
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Photo

[IPress the key shown to turn on the
[Photo] indicator.

v

> 21 OZoom D

>3l O Direct.Mag.
%)

| Image Density

Dark
OOriginaI
OlLight

Original

Oleft

gt D ORight

— ()
o | ]

ammmnmnnd [
Lighter Darker
(i

CE2A0104 |

Copy Media

O Vellum
OFilm

Image Edit

OFrase Border

Oior Imle
Positive/
Ohegative

& Note

O To adjust the copy image density, use the
[ Darker] or [Lighter] key.

3 If you do not wish to select any other func-
tions, set your original and start copying.

3 You can also choose [ Dark Original )/
[Light Original ] when [ Photo ] is selected.

@ Limitation

3 You cannot select [ Photo] while the
[Memory Copy] indicator is lit.



| NN T » [N 7T

SELECTING COPY PAPER

SELECTING COPY PAPER

Paper Tray Select/Auto Pa-
per Select

& Preparation

3 You can select copy paper types in two
ways:

[ Auto Paper Select)

The copier automatically selects a paper type

appropriate for a specified original size and

reproduction ratio.

[ Paper Tray Select]

You can select a paper tray manually.

A Reference

Original and paper widths to be read difter de-
pending on whether Size mode setting is set
to Engineering or Architecture sizes.

See “Original and Paper Sizes That Can Be
Read Automatically”” => Page 3

For the procedure to switch between columns
Engineering sizes or Architecture sizes, see
“Size mode setting.” => Page 71

Selecting Copy Paper Automati-
cally

® Limitation

O Auto Paper Select detects original widths
of 17,0", 22,0", and 34,0" (for Engineering
sizes) based on the left original guide po-
sition, and selects paper width automati-
cally (18,0", 24,0", and 36,0" for Architec-
ture sizes).

i] Press the key shown to turn on the {Auto
Paper Select] indicator.

E Set your original while fitting the origi-
nal guide to the original width.
The copier selects a paper type appro-
priate for the original width, and [11€3]),
[2w]), or [31€] goes on.

*

O Synchro D OFull Size D o+ D Oup
OpPreset/ O futoPaper ©= O Dowr
Variable O it Reducel
Enlarge Leading

Edge Shift Ii

> 1l OPresetReduce/ | IEEIIUT]
Enlarge

>21 OZoom D o+ D Oleft

> 31 O?u}n']m'm o= ORight

et ——SI
a (T

& Note

O If the appropriate paper is not loaded, the
message “Check paper size” appears on the
panel display.
Check the paper trays and select the cor-
rect type of paper.

O If you do not wish to select any other func-
tions, set your original and start copying.

Selecting a Paper Tray

n Press the key shown to turn on indica-
tor [11€ ], [21€3]), or [3193] to select the
paper type you require.

-
OSynchro D OFaull Size D o+ D Oup
OPreset/ O o baper o— ODown
Variahle O Auto Reduce/
Enlarge Leading St
> 1 O Preset Reduce/ | [RUECIIAT p -
Enlarge
> 21 O 2Zoom D o+ D OlLeft
>3 o ‘Ig/inr’ecl.Man. o=- ORight
Copy Media | Image Density I’ 1 I r
O Vellum ﬂ ngi'nkiml ﬂ I O Photo ﬂ |
& Note

O The third paper tray is optional.

O When selecting the manual feed table, press
the key shown to turn off indicators [ 1155 ]
to [31g3 ). => Page 16, “COPYING ONTO
PAPER SET ON THE MANUAL FEED
TABLE”

O If you do not wish to select any other func-
tions, set your original and start copying.
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COPYING

Auto Reduce/Enlarge

This function enlarges/reduces copies auto-
matically so that they match the specified pa-
per width.

RRR-R

[ Preparation

O This function is useful when copying origi-
nals of different sizes onto copy paper of
the same size.

® Limitation

O This function will use one of the following
reproduction ratios: 200, 129, 100, 65 and
50 % for Engineering sizes, and 200, 133,
100, 67 and 50 % for Architecture sizes.

B Preparation

For paper and original widths that can be read
automatically, see “Original and Paper Sizes
That Can Be Read Automatically.” => Page 3.

i] Press the key shown to turn on the [ Auto
Reduce/Enlarge] indicator.

O Synchro l:] OFull Size D o+ D Oup
OPreset/ Qe o— O Dow

Variable O Auto Reduce/
Enlarg

Leading

Edge

>l O PresetReduce/ | JICIIDNY

Enlarge
Cet Ozoom D o+ D Oleft
>3 o g/iur'm.lhg. o— ORight

Copy Media | Image Density CE2A0109
I - J

B Press the key shown to select a paper
tray containing your desired paper.

~
Osynchro D OFull Size D o+ D Oup
OpPreset/ AL o= O Down
Variable O Ato Reduce/

— Enlarge Leading Ed J—

> Oprstrees I g !
nlarge
> 21 Ozoom D o+ D Oleft
>3 Oaiﬁr’!ﬂ-mu- o= ORight
Copy Media | Image Density I’ﬁ r
Ovellum [] [ oBerk ) | ophoto [ | CE2A01087]
& Note

O If you do not wish to select any other func-
tions, set your original and start copying.
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SETTING THE LENGTH OF ROLL PAPER CUT

SETTING THE LENGTH OF ROLL PAPER CUT

F] Preparation
O You can cut roll paper in three ways:
[Synchro Cut)
Cuts roll paper to the same length as originals.
[Preset Cut)
Cuts roll paper by a length selected from the predefined, fixed lengths and two user-defined
lengths.
[Variable Cut)
Cuts roll paper by the length you enter.
O Roll paper is cut regardless of original sizes (except when using Synchro Cut).
O The predefined, fixed lengths for Preset Cut depend on the paper size type (Engineering sizes
or Architecture sizes) as shown in the following table.

Engineering Cut length 44.0" 34.0" 22.0" 17.0"
Architecture Cut length 48.0" 36.0" 24.0" 18.0"

O When you change Preset Cut/Variable Cut settings, roll paper will continue to be cut to the
modified length until the Auto Reset function is executed.
3 You can specify a Variable Cut length from 11" to 197" in 0.1" steps.

® Limitation
O You can cut roll paper to lengths between 11" and 197" when using Synchro Cut.

@ Note

O By default, [ Synchro Cut] is lit for the paper cut method. You can change this setting. =>
Page 69, “Set cutting method”

O You can store up to two Preset Cut lengths. => Page 73, “Copy length”

3 You can also select whether to show Synchro Cut lengths on the panel display. => Page 70,
“Synchr. cut length”

3 You can select the default paper sizes that are available (Engineering sizes or Architecture
sizes). => Page 71, “Size mode setting”

Synchro Cut

O Synchro D OFull Size
Obreset/ O AutoPaper
Variable o

i] Press the key shown to turn on the [ Syn-

O Auto Reduce/ .
—_ | Oknlarge Lea.d.lng eage | st
chro Cut]) indicator. AT @y || T
> 21 O2zoom D o+ D Oleft
@ Note > 31 Oyt o— ORigh

O If you do not wish to select any other func-

. . . e e ——E
tions, set your original and start copying. n i
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COPYING

Preset Cut/Variable Cut ﬂ Press the key shown so that the [Preset
Cut/Variable Cut] indicator blinks.

Preset Cut e————

i] Press the key shown so that the [ Preset
Cut/Variable Cut] indicator blinks.

O Synchro D ‘OFull Size
OpPreset/ O

Variable O Ao R
— | Oklarge Leading
> 1 OEreln(ﬁed\me/ Trailing o
nlarge
» 21 O Zoom D o+ D Oleft
>3 Og/lnr'en.ulng. o) — ORigh
I T R -
N T
Standard size cut AV #
100.0%

E Press the [A)/[ V] key until the cut
length you require appears on the panel
display.

B Press the [#] key.
The [Preset Cut/Variable Cut] indicator
will light.

& Note

O If you do not wish to select any other func-
tions, set your original and start copying.

Variable Cut

& Preparation
O When entering numbers, add leading ze-
roes as necessary. For example, if the value

requires 4 digits and you wish to set it to
299”7, enter “0299”.

24

O Synchro D OFull Size
OPreset/ G-

Variable O Al Reuce/
Enlarge Leading st
- e ift 1|
> 1 OEy?emeduael Trailing o
nlarge
> 21 O Zoom D o+ D OlLeft
>3l Oecles o— ORight

I R 257
N Lt J

g Press the [A)/[ V] until “Variable Cut”
appears on the panel display.

BPress the [#] key. The variable cut
length entry screen is displayed.

Set length Num. AV —#

100.0%

E] Use the [A)/[ V] or [ Number] keys to
select a cut length.
& Note

3 If you have entered a wrong number, use
the [A)/[ V] key or [ Number] keys to
enter the correct one.

B Press the [#] key.
The [Preset Cut/Variable Cut] indicator
lights.

& Note

3 If you do not wish to select any other func-
tions, set your original and start copying.
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FUSING TEMPERATURE

FUSING TEMPERATURE

This feature lets you select an optimal fusing
temperature for the type of media you are
copying onto.

& Preparation

O Choose one of the following fusing tem-
perature options that best matches your
copy media:

[Vellum Paper]

Select this option when copying onto trans-
lucent paper.

[Film)

Select this option when copying onto film.
[Bond Paper]

This option is selected when both the [ Vel-
lum Paper] and [Film] indicators are not
lit.

O Copies might be creased or part of images
might be lost if you make copies with a
fusing temperature inappropriate to your
copy paper.

O When you change the fusing temperature,
it might take a few minutes for the copier
to enter the ready condition.

@ Note

O You can adjust the fusing temperature in
the range of -5 to +5°C in about 1°C steps.
=> Page 65, “Adjusting the Fusing temp.
Temporary.”

O The specified fusing temperature is cleared
when you press the [ Clear Modes/Energy
Saver] key or change paper types.

3 You can select the default fusing tempera-
ture for each paper type. => Page 68, “Fus-
ing temp. adjustment.”

[I Press the key shown to turn on the [ Vel-
lum Paper] or [Film] indicator.
The message “Warming up” appears on the
panel display.

Image Edit

OFrase Border

O Mirror Image

Positive/
ON jative

™
» 21 OZoom D o+ D Oleft
>3 O&]m.uag. o=— ORight
Copy Media | Image Density E] [
OVellum oBark OPhoto
Original

OFilm OLi OAlm Iml

ﬁglnal % E]

Lighter

Darker

(
qlllllll'-[
LI

.

CE2A01147]

B Select any copy functions your require
and enter the number of copies.

B Set your original.
You can make copies after the copier fin-
ishes warming up.
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COPYING

PROGRAM

If you find that you often use the same group of
copy settings and get tired of selecting them
over and over again for each copy job, store
this group of settings in a Program. Once
stored, you can quickly and easily recall these
settings using the Recall Program key, then
carry out the copy job.

E Preparation

O To use the Program function, store copy
job settings you want to use repeatedly.
This operation is called “Store program.”

3 You can store up to five programs.

O The programs are numbered 1-5. Note that
if you store settings in a program that has
already been used, the old settings will be
overwritten with the new settings.

@ Note

O If you choose Auto Paper Select as one of
the settings stored in a program and paper
of the same size is loaded in more than one
roll feeder, the lowest number tray takes
priority.

O Unless you overwrite a program with new
settings, programs remain memorized even
when you turn off the machine or press the
[ Clear Modes/Energy Saver] key.

Storing/Changing a Pro-
gram

[I Select all the settings and functions that
you wish to store in a program.

E Press the [User Tools] key.

........

B Press the [A)/[ V] key to show 2. Store
program” on the panel display.

AV

User Tools
Store program

E] Press the [#] key
“Program 17 is shown on the panel display

B Press the [A)[ V] key to select the pro-
gram number (1-5) you wish to store
these settings in, then press the [#] key.

E If you wish to store another program,
repeat steps [1] to [S].

@ Note

O Press the [User Tools] key to return the
copier to the ready condition.

Recalling a Program

n Press the [Recall Program] key.

g Press the [A)[ V] key to select the pro-
gram you wish to recall (1-5).

Recall AV
Program 1

B Press the [#] key.
The programmed functions are shown on
the panel display.

ﬂ Set your original.
The copier starts copying.
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OTHER FUNCTIONS

OTHER FUNCTIONS

Energy Saver Mode

Auto Start

When you press the [ Clear Modes/Energy
Saver] key, the display goes blank and the ma-
chine enters Energy Saver mode.

& Preparation

O By default, Energy Saver is set to “Level
2” (the machine returns to the ready con-
dition after about three minutes). => Page
70, “Energy saver”

O Energy Saver mode uses less power than
the normal stand-by mode.

1k Important

O If you press the [ Clear Modes/Energy
Saver ] key while you are specifying a num-
ber or function, all settings you have en-
tered will be cleared.

i] Hold down the [Clear Modes/Energy
Saver] key for about three seconds.
The [Clear Modes/Energy Saver ] indica-
tor will light.

| Shift Image

ORight

@/g\w;ﬁﬁ(
&

1 E E] Preview Copy
4 : : Roll Edge Cut

7 8 9 Ex’wﬂﬂy Stop CE2A0117

@ Note

O To exit Energy Saver mode, press the
[ Clear Modes/Energy Saver] key again.

If you set up a copy job while the machine is
warming up ,the machine starts copying auto-
matically as soon as it enters the ready condi-
tion.

[I Select any functions you require and
enter the number of copies while
“Warming up” and “Auto Start” are
shown alternately on the panel display.

B Set your original.
The message “Please wait” is shown on
the panel display.

@ Note

O When you use Memory Copy, “Ready to
set original” is shown on the panel display.
O The center reference mark (arrow) blinks
while “Auto Start” is shown on the screen.

27
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COPYING

Interrupt (The Memory Unit
is Required)

If the machine is making copies, you can in-

terrupt the current copy run to copy another

original using Memory Copy, or by recalling

a stored original (with the hard disk).

E] Preparation

3 You can press the [ Interrupt ] key to inter-
rupt the current copy run when you are per-
forming the following operations using
Memory Copy:

* Scanning an original
e Copying (printing out)
* Recalling a stored original

O When the machine is scanning an original,
it finishes the scan before interrupting the
copy run.

O When the machine is making a copy, it de-
livers the copy before interrupting the copy
run.

O During a copy interruption, you cannot use
Memory Copy (Sort/Stack) or store/recall
an image.

i] Press the [Interrupt] key.
The [Interrupt] indicator lights.

N
O Interrupt

am

ODown ey

Leading

Traling  09¢ | Shiftimage Oo0nLine

OlLeft

Clear Modes/
Oy e

e )
1 2 3 Preview Cop)
| 2? ':olw ﬂ r 10 10 Al @ j

g Carry out your copy job.

ORight

B When you have finished your copy job,
press the [Interrupt]) key again.
The [Interrupt] indicator goes off. The
suspended memory copy run will be re-
sumed.

@ Note

O After interrupting a copy run, follow the
steps shown below.

If you interrupted scanning an original
O Insert the next original or press the [#] key
to start copying.

If you interrupted copying (printing out)
O Resume copying.
‘When the message “Print out?” is displayed,
press the [#] key.
When you interrupted recalling a stored
original
@ Continue the recall operation.



PRESET REDUCE/ENLARGE

You can select a preset magnification/reduc-

tion ratio for copying.

R <

& Preparation

O This function provides eight fixed repro-
duction ratios (four magnification ratios
and four reduction ratios) and two arbitrary
reproduction ratios:

Relationship between the Fixed Repro-
duction Ratios and Original/Paper Sizes

Engineering

Magnification ratio | 314%, 259%, 129%

@ Note

3 You can select a reproduction ratio regard-
less of an original or paper size. With some
ratios, however, part of an image might be
lost, or margins might appear on copies.

O When you reduce a copy of an original hav-
ing thin lines, their thickness might differ
or part of them might be lost.

0 When you set the zoom increment to 0.1
%, the fractional portion of numbers is also
shown on the panel display. => Page 70,
“Change zoom inc.”

Tips

O By default, the arbitrary reproduction ra-
tios are 100 % for Magnification Ratio 1
and 200 % for Magnification Ratio 2. You
can change these settings to ratios you use
frequently.
=> Page 74, “Setting Preset Reduce/En-
large”

[I Press the key shown so that the [ Preset
Reduce/Enlarge] indicator blinks.

Reduction ratio 65%, 50%, 32%, 25%,

Arctecture

Magnification ratio | 400%, 267%, 133%

Reduction ratio 67%, 50%, 33%, 25%

O synchro O OFull Size o+ Oup
Preset / O - E]
OVari:I:ls Select [e) O Dowr
— Leading
> 1 Trailing
>21
>3

Copy Media

| Image Density

29
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COPY SETTINGS

E Press the [ A )/[ V] key to select a repro-
duction ratio.

Preset R/E AV i
141% 841X ---mm
B Press the [#] key.
The [ Preset Reduce/Enlarge) indicator
lights.
E] Set your original.

The copier starts copying.

30



ZOOM

ZOOM

You can specify the magnification/reduction
ratio in 1 % or 0.1 % steps to change copy
image sizes more subtly.

\\

RRERR

[ Preparation

O Use the [A)/[ Y] key or [ Number] keys
to specify the reproduction ratio.

0 When entering numbers, add leading ze-
roes as necessary. For example, if the value
requires 3 digits and you wish to set it to
“50”, enter “050”.

3 You can specify the reproduction ratio in
the range of 25 to 400 %.

Tips

3 You can also choose a ratio nearest to the
one you require by choosing [Preset Re-
duce/Enlarge ] and then selecting [ Zoom ).
Fine-tune the ratio with the [A }/[ V] key.

& Note

O You can also change the reproduction ra-
tio increment to 1 % or 0.1 %. => Page 70,
“Change zoom inc.”

O When you reduce a copy of an original hav-
ing thin lines, their thickness might differ
or part of them might be lost.

[I Press the key shown so the [Zoom] in-
dicator blinks.

O Synchro D OFaull Size o+ D Oup
OPreset/ Ol baper o— ODowr
Variable O Al Reucel
— Enlarge Leading St
> 1 O Preset Reduce/ Trailing o .
Enlarge
> 21 Ozoom D o+ Oleft
>3l Omm.uag, o= ORight
I R 770775
N L{CH 1
Zoom Num. AV —#
100.0% 34.0"x 17.0"

gPress the [A)/[ V] key or [ Number]
keys to specify a reproduction ratio.
& Note

O If you enter a wrong number, use the [A)/
[v] key or [ Number] keys to enter the
correct one.

B Press the [#] key.
The [Zoom] indicator becomes lit.

E] Set your original.
The copier starts copying.
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COPY SETTINGS

DIRECTIONAL MAGNIFICATION

This feature lets you specify different repro-
duction ratios for the vertical and horizontal
axes. To put it simply, you can stretch the im-
age horizontally and vertically.

R»

IS

0 T
——

Horizontal

E Preparation

3 Use the [A)/[ V] key or [ Number] keys
to specify the reproduction ratios.

O When entering numbers, add leading ze-
roes as necessary. For example, if the value
requires 3 digits and you wish to set it to
“50”, enter “050”.

3 You can specify the reproduction ratios in
the range of 25 to 400 %.

& Note

3 You can also change the reproduction ra-
tio increment to 1 % or 0.1 %. => Page 70,
“Change zoom inc.”

O When you reduce a copy of an original hav-
ing thin lines, their thickness might differ
or part of them might be lost.

32

[I Press the key shown so the [ Directional
Magnification]) indicator blinks.

O Synchro D OFull Size o+ D Oup
OPreset/ O o Faper O/= ODow
Variable O Auto Reduce/

—_— | Oklarge Leading shift!

> 1 Preset Reduce/ | IULCIIL] 9 .
O Erarge

> 21 Ozoom D o+ Oleft
>3 o mm,mag. o= ORight

I T 77
N | J

B Press the [A)[ V] key or [Number)
keys to specify a horizontal reproduction
ratio.

Direct. Magnif. N. AV #
Width 120%
& Note

O If you enter a wrong number, use the [A)/
[v] key or [ Number] keys to enter the
correct one.

B Press the [#] key.
The vertical ratio entry screen is displayed.

E]Press the [A)/[ V] key or [Number]
keys to specify a vertical reproduction
ratio.

Direct. Magnif. N. AV #
Length 100%

B Press the [#] key.
The [ Directional Magnification ) indicator
lights.

m Set your original.
The copier starts copying.



ERASE BORDER

ERASE BORDER

This function erases shaded areas around origi-
nal images.

>
MM
M
>
MM
M

& Preparation

O By default, the bounding margin around all
four edges that is erased is 0.4".

O You can specify erase widths in the range
of 0 to 2"in 0.1" steps.

® Limitation
3 You cannot select Erase Border while the
[[Synchro Cut]) indicator is lit.

& Note

3 You can also combine Erase Border and
Positive/Negative when you set the “Im-
age creation” initial setting to “combined
function.” => Page 34, “MIRROR,” Page
34, “POSITIVE/NEGATIVE,” Page 70,
“Image creation”

O You can change the default erase width.
=> Page 66, “Erase Border”

n Press the key shown so the [Preset Cut/
Variable Cut ] indicator blainks and then
select a cut length.

O Synchro D OFull Size
Obreset/ O o Faper
Variable O Auto Reduce/

—_—— | “Enlage Leading

> 1 O PrestReducs| Trailing  ~*%°

nlarge

> 21 Ozoom D o+ D Oleft

>3 Omm.uag. o= ORight
I R 201

N e J

Standrard size cut AV _#

100.0%

» Reference
“Preset Cut/Variable Cut” => Page 24

BPress the key shown to turn on the
[Erase Border] indicator.

> 215 Ozoom D o+ D Oleft
>3 omm.mg. o= ORight
Copy Media | Image Density E][
Dark
OVeIIumD oo,igina,[l OPhoto
OFilm OlLight O Auto Imag
Onginal Doy E][
Image Edt Onginal — | Th
e
e — |Q0 8w mw @Dl (7
O Mirror Image, Lighter Darker
oz I
| -
CE2A0119
B Set your original.

The copier starts copying.
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COPY SETTINGS

MIRROR

Like a mirror, this function reverses copy im-
ages from left to right and vice versa.

POSITIVE/NEGATIVE

This function turns positive images to nega-
tive ones when copying originals.

@ Note

3 You can also combine Mirror with Erase
Border or Positive/Negative when you set
“Image creation” of initial setting to “com-
bined function.” => Page 33, “ERASE
BORDER,” Page 34, “POSITIVE/NEGA-
TIVE,” Page 70, “Image creation”

I] Press the key shown to turn on the [ Mir-
ror] indicator.

& Note

3 You can also combine Positive/Negative
with Erase Border or Mirror when you set
the “Image creation” of initial setting to
“combined function.” => Page 33,
“ERASE BORDER,” Page 34, “MIR-
ROR,” Page 70, “Image creation”

[I Press the key shown to turn on the [ Posi-
tive/Negative] indicator.

> 21
>3

OlLeft

oo U

¥
O Zoom D
O Direct.Mag.

(%)
| Image Density

Dar
o Orlglnal O Photo
OLight

ol | ]

ORigh

Copy Media

OVellum D

Image Edit

Original

Glllllll' -[

OErase Border

> 21
>3

Oleft

oo U

ORigh

™
O Zoom D
O Direct Mag.

(%)
| Image Density

Dar
o Orlglnal O Photo
OLight

cl| ]

Copy Media

OVellum D

Image Edit

Original

Glllllll' -[

Ograse Border

OMu-anmageD Lighter Darker OMi'mlm-?D Lighter Darker
. ci .
~ CE2A01207] ~ CE2A01217]
E Set your original. g Set your original.

The copier starts copying.

The copier starts copying.
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MARGINS

MARGINS

This function creates a margin on the top (lead-
ing edge) or bottom (trailing edge) of copies

or cuts off unnecessary portions of copies.

Leading edge margin ( +)

- R

Leading edge margin ( -)

0

Yy
i

Trailing edge margin ( +)

=>

0

Trailing edge margin ( -)

Yy
f

& Preparation

0

)

This function allows you to select the fol-

lowing four types of margins:

¢ Leading edge margin (+): Creates a mar-
gin on the top (leading edge) of copies.

* Leading edge margin (-): Cuts an unnec-
essary portion on the top (leading edge)
of copies.

¢ Trailing edge margin (+): Creates a mar-
gin on the bottom (trailing edge) of cop-
ies.

e Trailing edge margin (-): Cuts an unnec-
essary portion on the bottom (trailing
edge) of copies.

Use the [A)/[ V] key or [ Number] keys

to specify margins.

When entering numbers, add leading ze-

roes as necessary. For example, if the value

requires 3 digits and you wish to set it to

“50”, enter “050”.

You can specify margins in the range of

-8" to 8" in 0.1" steps (negative numbers

represent cut lengths).

A copy length is a paper length plus a mar-

gin or minus a cut length.

@ Note

0

You can change the default margin settings.
=> Page 66, “Margins”
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COPY SETTINGS

i] Press the key shown so the [+] or [-]
indicator for [ Leading Edge] or [ Trail-
ing Edge] blinks.

The default margin setting is shown on the
panel display.

Onterrupt
ul Size 2
ltoPa
ok oz
uce
flarge Leading )
—_— Edge | shiftimage
feset Recuce/ | ICULT] ©QOnLine|
ferge
foom D Oleft D [ ad
lr)m-"ll!- ORight E Ommv
/@
1 2 3 Preview Copy
(] |2 ]
t O hutoma s
a0 Ot | (4 ][5 ][6 ) cesor
=

Set lead. edge N. AV #

+2,0"

Set trail. edge N. AV #

@ +2,0"

E Press the [A)/[ V] key or [ Number]
keys to specify a margin or cut length.

@ Note

O If you have entered a wrong number, use
the [A)/[ V] key or [ Number] keys to
enter the correct one.

B Press the [#] key.
The [+] or [-] indicator lights.

E] Set your original.
The copier starts copying.
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IMAGE SHIFT

IMAGE SHIFT

This function shifts a copy image upward/
downward or left/right to make a margin.

Image Shift ( Lead )

»
R -
Image Shift ( Trail )
R -
»
R

Image Shift ( Left)

0

Image Shift ( Right )

=>

0

& Preparation

O This function allows you to select the fol-
lowing four types of shift:

e Up: Moves an original image toward the
top (leading edge) of a copy.

*  Down: Moves an original image toward
the bottom (trailing edge) of a copy.

e Left: Moves an original image to the left
of the original feed direction.

e Right: Moves an original image to the
right of the original feed direction.

0O Use the [A)/[¥] key or [ Number] keys
to specify shift widths.

O When entering numbers, add leading ze-
roes as necessary. For example, if the value
requires 3 digits and you wish to set it to
“50”, enter “050”.

0 You can specify shift widths in the range
of 0 to 8"in 0.1" steps.

O If you are using roll paper, it is cut by the
length specified for Preset Cut or Variable
Cut. When you specify Image Shift to-
gether with Synchro Cut, the copy might
be longer than the original.

& Note
O You can change the default shift widths.
=> Page 66, “Image Shift”

37



| NN T « [N T

COPY SETTINGS

i]Press the key shown so the [Up],
[Down], [Left], or [Right] indicator
blinks.
The default shift width is shown on the
panel display.

Olnterrupt|
ull Size
futo Paper
lelect

uto Reduce/
[nlarge Leading

feset Reduce/ | JRCEIIAC]
flarge

foom D
ir)eﬂ.lﬁlg,
inal |:|

it
inal

Oup

QO Down Memow

DOCo py
i-:ﬂ

Edge | Shift Image

Oleft
ORight

/@
1 2 3 Plgview Copy

OPhoto D
Aol -
ot | )5 5] oo

Set image shift N. AV #
Ttail 0.4"

E Press the [A)/[ V] key or [ Number]
keys to specify a shift width.

& Note

O3 If you enter a wrong number, use the [A)/
[v] key or [ Number] keys to enter the
correct one.

B Press the [#] key.
The [up]), [Down], [Left]), or [Right)
indicator becomes lit.

E] Set your original.
The copier starts copying.
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PREVIEW COPY

PREVIEW COPY

This function makes a partial copy (11" long
from the leading edge) of an original in the
original feed direction. Use this feature to
check image quality with the current settings
before starting a copy run.

'R

(Example of a preveiew
copy for "Positive /
Negative")

=
!

Function Preview

Image Density Preview

R

E Preparation
O Your machine is furnished with two types
of preview feature:
¢ Function Preview: Allows you to check
the Mirror, Positive/Negative, or other
functions.
* Image Density Preview: Copies the lead-
ing portion of an original with seven lev-
els of image density on a 1" basis.

@ Note

O When you make an image density preview
copy, the Image Shift (Up/Down), Margins,
and Reduce/Enlarge functions are disabled.

O If you choose [ Auto Image Density ], You
cannot select Preview Copy.

i] Select any copy functions you wish to use,
then press the [Preview Copy] key.
Gan D jE=

ODown Olemery

Leading

Edge | Shift Image

Trailing

O0n Line

Cearlotes/
Oknergy Saver

Oleft D E
ORight
X

(O J[2 J[8 ] erevencon
EN

O Photo

; ; ;. 7 1@ e Emmmg,Eonwt

B Press the [ A }/[ V] key until “1. Preview
image” or ‘2. Preview contrast’ is shown

on the panel display.
Preview copy AV #
1. Preview image
Preview copy AV #
2. Preview contrast

@ Note

When using Memory Copy, you can also se-
lect “3: full sample.”

B Press the [#] key.

E] Set your original.
The copier starts copying.

& Note

O When the copy run starts, the original is
fed a little and delivered back to position.
Then it is kept on the original table.

O After preview copying, press the [#] key
when you want to start copying the entire
original with the these copy settings.

O To cancel copying the original, press the
[Emergency Stop] key and remove the
original.
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COMBINATION CHART

COPY SETTINGS

apow pajos|as Apeaily
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*

Feed

function” for these modes.
@ : These modes cannot be used together. The mode you try to select will be the mode you are

working in.
+ : Only the Trailing Edge Margin (+) can be used together with Synchro Cut.

working in.
x : These modes cannot be used together. The already selected mode will be the mode you are

Adjusting
Image
Density
Paper
Paper
Type
Memory Copy

Normal Original means a state in which both Dark Original and Light Original are not selected.
512345678900~

~ : These modes can be used together the when the Image creation initial setting is set to*“‘combined

O : These modes can be used together.
Note: Text means a state in which both Auto Image Density and Photo are not selected.
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IF YOU CANNOT START COPYING

If a Message Appears

This section describes messages shown on the panel display. If you see a message other
than those in the table below, follow the instructions given in the message.

Message

Problem/Cause

Action

Warming up

This message appears
when you turn on the main
switch.

Wait for the machine to warm-up.

You can specify copy functions and the num-

ber of copies during the warm-up period. =>

Page 27, “Auto Start”

& Note

* ]t takes up to 10 minutes for the machine to
enter the ready condition when you turn on
the main switch.

No roll unit

The roll feeder is not set
firmly in a selected paper
tray.

Open the front cover and push the roll feeder
firmly. => Page 48, “IF COPY PAPER RUNS
ouT”

Check paper size

There is no copy paper that
matches an original you set
when the [ Auto Paper Se-
lect] indicator is lit.

Change the roll paper and start copying. Al-
ternatively, turn on the [ Auto Reduce/En-
large ] indicator with the relevant key to en-
large/reduce copies. => Page 48, “IF COPY
PAPER RUNS OUT,” Page 22, “Auto Re-
duce/Enlarge”

Close original

The original holder is not

Fix the original holder firmly with the pins

holder fixed with the pins. on both sides.

Close doors and | The front cover is open. Close the front cover firmly.
covers

Close doors and | The main unit is open. Hold the original table with both hands and
covers push it toward the rear side of the machine to

close the main unit. Make sure that the main
unit release lever is returned to the original
position.

The upper rear cover is
open.

Close the upper rear cover firmly.

The right side cover is open.

Close the right side cover firmly.

Please wait

The machine is adjusting its
temperature because you
have changed the fusing
temperature.

Wait for the machine to adjust to the new tem-
perature.

*
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WHAT TO DO IF SOMETHING GOES WRONG

Message

Problem/Cause

Action

Memory full
Eject original?

The machine has run out of free
memory space.

If you select “Yes,” the original is ejected.

If you select “No,” remove the original
manually.

When you press the [#] key after ejecting/
removing the original, the machine prints
out the originals it has already scanned.

Memory unit
error
Press any key

You cannot make copies with
memory because the Memory
Unit is not working properly.

Contact your service representative. How-
ever, you can still make copies without us-
ing memory. Press any ley to return to the
“Ready” screen.

Turn on the
memory unit

The Memory Unit’s power cord
is unplugged from the connector
on the back of the machine.

Plug the power cord in firmly. If the mes-
sage appears again after you have made
sure that the power cord is plugged in, con-
tact your service representative.

Select lighter
exposure, set
original again

You are trying to store in
memory a large-size blueprint
original, or an containing many
photographs, maps, or other
halftone images.

Lighten the copy image density with the
[Lighter] key, or change the image qual-
ity level from “Fine” to “Normal.” Change
the original feed orientation from [ to [).

Paper empty
Remove
remaining paper

The end portion of the roll paper
is stuck to its roll. If the remain-
ing paper is too short, the machine
will not cut it.

Open the front cover and remove the pa-
per.

Now adding | The machine adds and shakes the | Make sure that the toner is added, and wait
toner toner after you supply it. for the message to disappear.
Please call When this message appears with a num-
service ber, pull the release lever to open the main
unit, and then close it. If the message ap-
pears again, check the number and other
information given in the message, turn off
the main switch, and unplug the power
cord. Then contact your service represen-
tative.
Maintenance | Machine maintenaice is due. Contact your service representative.
due.




| NN T » [N 7T

IF YOU CANNOT START COPYING

Others

Problem

Cause

Action

The [Clear Modes/Energy
Saver] indicator is lit and the
panel display is turned off.

The machine is in Energy
Saver mode.

Press the [Clear Modes/
Energy Saver] key.

Nothing appears on the panel
display even when you turn on
the main switch.

The power code is not plugged
in the outlet.

Plug the power cord in the
outlet.
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WHAT TO DO IF SOMETHING GOES WRONG

IF YOU CANNOT MAKE CLEAR COPIES

Problem Cause Action
Black lines The image density | Adjust the image density.
appear on is too dark. => Page 18, “ADJUSTING COPY IMAGE DENSITY”
copies. The exposure glass | Clean the exposure glass and original feed roller.
or original feed | Cleaning the Exposure Glass
roller is dirty.
There is foreign
matter or dust on
the originals.
Cleaning the Original Feed Roller
Wipe the original feed roller while rotating the part
@ indicated by (1) in the illustration below.
Remove the foreign matter or dust from the originals
before copying.
In particular, be careful when copying the following
types of originals:
1. Originals containing characters in pencil, either
handwritten or plotter-generated.
2. Film or translucent paper originals which easily build
up static electricity.
3. Originals long enough to reach the floor.
The revercse | The image density | Adjust the image density.
side of is too dark. => Page 18, “ADJUSTING COPY IMAGE DEN-
an original SITY”

44
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IF YOU CANNOT MAKE CLEAR COPIES

Problem Cause Action
Copies appear dirty. The image density is | Adjust the image density.
too dark. => Page 18, “ADJUSTING COPY
IMAGE DENSITY”
A shadow appears on copies if [ The image density is | Adjust the image density.

you use pasted originals.

too dark.

=> Page 18, “ADJUSTING COPY
IMAGE DENSITY”

¢ Change the original feed orientation.
* Put mending tape on the pasted part.

Something other than original
images is copied

The exposure glass or
original feed roller is
dirty.

Clean the exposure glass and original
feed roller.
=> Page 44

Copy images are blurred. The image density is | Adjust the image density.
too light. => Page 18, “ADJUSTING COPY
IMAGE DENSITY”
Unsuitable paper is | Check non-recommended paper.
set. =>Page 5
& Note
* If you make a copy on rough-grain,
coated, or damp paper, the copy im-
age might be blurred.
Toner is not fused properly. The fusing tempera- | Specify a fusing temperature appropri-

ture is too low.

ate to the paper type.

=> Page 25, “FUSING TEMPERA-
TURE,” Page 68, “Fusing temp. ad-
justment,” Page 65, “Adjusting the Fus-
ing Temperature Temporarily”

Copies are made onto
thick paper.

Specify a higher fusing temperature.
=> Page 65, “Adjusting the Fusing
Temperature Temporarily”

A moire pattern is
produced on copies.

R-H

The moire pattern is
created because regu-
larly arranged dot pat-
terns or lines overlaps
when the image is pro-
cessed.

The moire pattern might not be pro-
duced if you change the original ori-
entation.

Copy the original in the Photo mode.

Copies become lighter
when continually copying
a solid, black image.

Open and close the right side cover and
wait for a while.
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WHAT TO DO IF SOMETHING GOES WRONG

IF YOUR COPIER
DOES NOT OPERATE AS YOU WANT

Problem

Cause

Action

Misfeeds occur fre-
quently.

Copy paper is folded or
creased.

Cut the folded or creased portion of the
roll paper.

Misfed paper or pieces of
paper remain inside the
machine.

Remove such paper in an appropriate way.
=> Page 56, “IF COPY PAPER OR AN
ORIGINAL IS MISFED”

The original is curled.

Straighten the curled portion of the origi-
nal before copying.

Partof'acopy image is lost
when using Erase Border.

The erase width is too
large.

The original you set has
00 narrow a margin.

Set the default erase width to a smaller
value. => Page 66, “Erase Border”

Part of a copy image is
lost.

The original was not set
in the correct position.

Set the original properly.
=> Page 14, “SETTING ORIGINALS”

An unsuitable paper size
is selected.

Select copy paper of the correct size.
=> Page 4, “Recommended Paper Sizes
and Types”

Image Shift or Leading
Edge Margin (or Trailing
Edge Margin) is selected.

Press the relevant key to turn off the [ Im-
age Shift] or [ Leading Edge Margin] (or
[ Trailing Edge Margin]) indicator. =>
Page 37, “IMAGE SHIFT,” => Page 35,
“MARGINS”

An original image is not
copied.

The original was set with
the wrong side facing down.

Set the paper with the side you wish to
copy face-down.

The copy image is shifted
horizontally on the copy

paper.

The roll paper is not set
properly in the roll feeder.

Align the roll paper properly to the size
indicator on the roll spool. => Page 48,
“IF COPY PAPER RUNS OUT”

The original size does not
match the size indicators
on the original table.

Align the original guides to the size indi-
cators and insert the original along them.
=> Page 14, “SETTING ORIGINALS”

The copy paper was not
inserted properly when
copying with manual
feed.

Align the copy paper propetly to the size
indicator on the manual feed table. =>
Page 16, “COPYING ONTO PAPER SET
ON THE MANUAL FEED TABLE”

The copy image is shifted
in the original feed direction
(on the opposite direction)

Copies are shorter than the
specified length, or they
are cut at some midpoint.

Image Shift or Leading
Edge Margin (or Trailing
Edge Margin) is selected.

Press the relevant key to turn off the [Im-
age Shift] or [ Leading Edge Margin] (or
[ Trailing Edge Margin]) indicator. =>
Page 37, “IMAGE SHIFT,” => Page 35,
“MARGINS”
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IF YOUR COPEIR DOES NOT OPERATE AS YOU WANT

Problem

Cause

Action

Copies are creased.

The copy paper is
damp.

Replace the copy paper with new one.
Turn on the anti-condensation heater.
=> Page 6, “Anti-humidity Heater”

Copies are slanted.

The originals were not
fed straight.

Feed the originals straight along the original
guides.

Copies are waved.
(on translucent pa-
per)

The fusing tempera-
ture is too low.

Specify a fusing temperature.

=> Page 68, “Fusing temp. adjustment,” Page
65, “Adjusting the Fusing Temperature Tempo-
rarily.”

The reproduction ra-
tio is inappropriate
for full-size copying.

The default full-size re-
production ratio is in-
appropriate.

Adjust the default full-size reproduction ratio.
=> Page 67, “Magnif. adjustment”

Data other than origi-
nal images is copied.

The hard disk is dam-
aged.

Format the hard disk and store the copy job set-
tings again. Ask your service representative.

A trailing edge mar-
gin is made on a copy
when reducing the
copy image using
Synchro Cut.

The margin is made
because copy paper is
fed into the machine
first.

Enable the Pre-scan function.=>P.88,”Pre-
scan(Reduction)”

A trailing portion of
an image is not cop-
ied when copying an
original containing
halftones.

The copy is made in
the Text mode.

Set Background setting to Lighter and make
copies in the Photo/Light Original mode when
copying an original having text and halftones.

A paper misfeed oc-
curs and the machine
sounds abnormally
when roll paper is
running out.

A paper misfeed oc-
curs if the end portion
of paper is pasted on
the roll.

Open the front cover and remove the roll paper.
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WHAT TO DO IF SOMETHING GOES WRONG

IF COPY PAPER RUNS OUT

5 Reference

For the sizes and types of paper you can set,
see “Recommended Paper Sizes and Types.” ¥
=> Page 4 =

i] Open the front cover.
& Note

0 When opening the front cover, close the CE9P0200
manual feed support table.

ﬂ B Check the paper roll direction and set
Hold the front part of the roll feeder to the new roll paper on the roll spool.
release the lock. Then pull out the feeder.

CE9P0300

& Note

B Remove the roll paper. O Align the side edge of the roll paper to the
scale on the roll spool.

O When you release the lever, the roll paper
is fixed on the roll spool.

O The scale on the roll spool is the reference
for aligning roll paper. To align roll paper
precisely, set it in position based on actual
copy sizes.

CE3R0300 Roll spool

E] Remove the roll spool while pressing the
lever.

CE9P0400
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IF COPY PAPER RUNS OUT

E Set the roll paper in the roll feeder.

1k Important

0 When setting the roll paper in the roll
feeder, be careful not to pinch your fingers
between the paper and the guide grooves
in which you set it.

CE3R0300

ﬂ Open the paper feed guide while hold-
ing the levers.

Setting the Roll Paper in the First Roll

Feeder

O Feed the paper under the black sheet by
about 0.4".

CE3R0501

Setting the Roll Paper in the Second/Third

Roll Feeder

@ Open the paper feed guide while holding
the levers as shown below.

@ Pull out the paper edge by about 0.4" as
shown below. Then close the paper feed
guide while holding the levers.

—

CE3R0601
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WHAT TO DO IF SOMETHING GOES WRONG

m Stretch the paper.

X

O <
V),

D Close the front cover.

The paper edge is set in position automati-

cally.

& Note
O If a message appears to indicating a paper
misfeed, set the paper again.

m Press the [ Cut Leading Edge] key.
The leading portion of the roll paper is cut
by about 1.2" and delivered from the copy

delivery slot.

Memor
olepy ™

n

Oontine
Oyt
/@

Roll Edge Cut
s 6 ) )
mergency Sto
L Je_Jle ] g™

Shift Image

Oleft
ORight

CE2A0125

& Note
O If the leading portion is cut at a slant or

irregularly, press the [ Cut Leading Edge)

key a few more times.
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IF THE WASTE TONER TANK FULL

IF THE WASTE TONER TANK FULL

/\ WARNING:

¢ Do not incinerate used toner, toner tank or toner cartridge.
e Toner dust might ignite when exposed to an open flame.
o

Dispose of the toner cartridge and the used toner tank
according to local regulations for plastics.

N\ CAUTION:

¢ Do not eat or swallow toner.
e Keep toner(used or unused), toner tank, and toner cartridge out

of reach of children.

A\ CAUTION:
2 ¢ This machine has been tested for safety using this supplier’s parts

and consumables. We recommend you only use these specified
supplies.

$ &P Note
O Put the Tank with full of the used toners in the vinyl bag and ask your service representative $
the way to dispose of it.
O Used toner cannot be re-used.
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WHAT TO DO IF SOMETHING GOES WRONG

i] Open the Right Cover. E] Set a new Waste Toner Tank into the
Copier

A\

E Remove the Waste Toner Tank by push- B Close the Right Cover.
ing down and pulling out towards you.

B Seal the Waste Toner Tank Opening
with the seal located on.
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IF TONER RUNS OUT

IF TONER RUNS OUT

This section describes how to supply toner when toner is low or runs out.

/\ WARNING:

¢ Do not incinerate used toner, toner tank or toner cartridge.
e Toner dust might ignite when exposed to an open flame.
o

Dispose of the toner cartridge and the used toner tank.
according to local regulations for plastics.

A\ CAUTION:

¢ Do not eat or swallow toner.
e Keep toner(used or unused), toner tank, and toner cartridge out

of reach of children.

A CAUTION:
f ¢ This machine has been tested for safety using this supplier’s parts

and consumables. We recommend you only use these specified

supplies.

1k Important

3 If you use toner other than that recommended, a fault might occur.

O Add toner with the power turned on. If you turn off the power, your copy settings are cleared
and you cannot resume a copy run.

O Always add toner after the machine instructs you to add toner.

O Set a toner cartridge in each of the left and right holders (two cartridges in total).

A Reference
For information on storing toner, see “Toner Storage.” => Page 7

@ Note

O You can still make several copies after the message “Toner is nearly empty” is displayed.
However, you should replace the toner as soon as possible.

O If toner runs out, the message “Add toner” appears and you cannot make copies.

0 When you supply toner, the copier automatically adds it for up to four minutes and shake it for
up to two minutes. While this is happening, the message “Now adding toner” is displayed.

O If you have been copying originals of high image density, you may not be able to fully replen-
ish the toner reservoir in one operation. Toner cannot be fully added at a time depending on the
image density of originals you have copied. If the message ‘“Toner is nearly empty” appears
again after supplying toner, open and close the right side cover. This lets the copierstart
adding the toner again.
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WHAT TO DO IF SOMETHING GOES WRONG

n Loosen both screws on the upper rear B Shake the new toner cartridge horizon-

cover and open it. tally and vertically 10 to 15 times to re-
move lumps.
% CE1B0100
<)
CE1B0200
E Open the toner supply cover. E] Remove the seal from the cap.

CE1B0300
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IF TONER RUNS OUT

B While holding both tabs on the cap, set
the toner cartridge on each of the left
and right holders in the machine.

E Holding it near the cap, and slide the
toner cartridge to the middle of the ma-
chine while tapping its bottom. Then
slide the cartridge back to the original
position.

& Note

O Slide the toner cartridge left and right a few
times for about 15 to 20 seconds, and leave
it for 2 or 3 minutes.

ﬂ Remove the toner cartridge from the ma-
chine while holding both tabs on
thecapas in setting the cartridge.

8 Repeat steps [5] to [7] to add toner from
the other holder.

m Close the upper rear cover and fasten
both screws on the cover.
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WHAT TO DO IF SOMETHING GOES WRONG

IF COPY PAPER OR AN ORIGINAL IS MISFED

A\ CAUTION:
@ e Since some parts of the copier are supplied with high electrical

voltage, touch only the parts specified in this manual, otherwise a
burn might occur.

1k Important

O When clearing misfeeds, do not turn off the power. If you do, your copy settings are cleared.

O Remove misfed paper carefully not to tear it. If torn scraps of paper remain within the ma-
chine, a paper misfeed might recur or a fault might occur.

O If paper misfeeds occur repeatedly, contact your service representative.

@ Note

0 More than one misfed areas might be indicated. In this case, check every applicable area.
e B, C, or D =>Page 57, “When B, C, or D is Displayed”
e S =>Page 58, “When S is Displayed”
e P =>Page 59, “When P is Displayed”
* A =>Page 60, “When A is Displayed”

O You can find a sticker explaining how to remove misfed paper in front of the roll feeder.

O If no misfed paper is found in the roll feeders when B, C, or D is displayed, release the lock of
the first and second roll feeders and set them again with the third one fixed. Then check the
third roll feeder.
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When B, C, or D is Displayed

When the following message appears, a pa-
per misfeed has occurred in the correspond-
ing roll feeder. Remove the paper by follow-
ing the steps shown below.

* B: First roll feeder

* C: Second roll feeder

 D: Third roll feeder (optional)

Clear Misfeed(s):B
Open front doors

i] Open the front cover.

E Hold the front part of the roll feeder
shown below to release the lock. Then
pull out the feeder.

E] Open the paper feed guide while hold-
ing the levers.

CE3R0401

E] Cut the creased or folded portion of the
roll paper with a cutter or scissors, if any.

CE3R09007-

B Roll the paper to remove slack from it.

I
CE3R09007-

B Feed the paper under the black sheet by
about 0.4".
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WHAT TO DO IF SOMETHING GOES WRONG

ﬂ Pull out the paper edge by about 1 cm.
Then close the paper feed guide while
holding the levers.

m Stretch the paper.

O

<
< J

D Press the [ Cut Leading Edge] key.

Memory
OCopy

n

O0nLine

Shift Image

Oleft
ORight

Cear ot/
Offery Sover.

o/®
L2 (8 eovencony

(]
:] @ Eggmy St CE2A0125
@ Note

O If the leading portion is cut at a slant or
irregularly, press the [ Cut Leading Edge)
key a few more times.

When S is Displayed

When the following message appears, a pa-
per misfeed has occurred in the manual paper
feed slot. Remove the paper by following the
steps shown below.

Clear Misfeed(s):S
Remove paper

[I Pull the misfed paper from the manual
paper feed slot.

B Pull down the main unit release levers
lightly to open the main unit.

CE#—\O200\_
I
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B Remove the paper from inside the ma-
chine. Be careful not to touch the part
labeled “High Temperature. Do Not
Touch.”

When P is Displayed

‘When the following message appears, an origi-
nal misfeed has occurred in the original feed
slot. Remove the original by following the
steps shown below.

Clear Misfeed(s)
Reset original

CE4A0300

E] Close the main unit.

[I Loosen the fixing pins on both sides on
the original cover to release the lock.

CE‘ﬁJOmO

B Open the original cover and remove the
misfed original carefully without tear-
ing it.

T

@ Note

0 When you pull up the original cover to a
certain position, it will lock and will not
close.

B Close the original cover.
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WHAT TO DO IF SOMETHING GOES WRONG

B Remove the paper from inside the ma-
chine. Be careful not to touch the part
labeled “High Temperature. Do Not
Touch.”

When A is Displayed

When the following message appears, the lead-
ing portion of paper is misfed within the

machine. Remove the paper by following the
steps shown below.

Clear Misfeed(s)
Open fusing unit

[I Pull down the main unit release levers ] T
lightly to open the main unit.

CE4A0301

E4A0201
1 |

B Open the right side cover and rotate the
paper feed knob clockwise.

.

1] 2
=

ﬁE‘4A08|00
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E] Press the fusing unit release button.

H Open the fusing unit and remove the
misfed paper from the copy delivery slot.

CE4A0700
="

E Close the fusing unit and main unit.
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ACCESSING THE USER TOOLS OVERVIEW

The User Tools let you change various default

settings to match the kind of copy jobs you

carry out most frequently.

E Preparation

O Any changes you make to the User Tool
settings are not cleared even when you turn
off the power, or press the [ Clear Modes/
Energy Saver] key (except for “Adjust the
Fusing Temperature Temporarily”).

Make sure that the copier is in the ready
condition.

ﬂ Press the [User Tools] key.

Program

Us
® Fusing
Temperature

Jser Tools
&
O

Olhmqn] E2A0101
= __ 1= cevon

B Press the [A)/[ V] and [#] keys to find
the setting you wish to adjust. The dia-
gram on the next page shows the avail-
able settings.

Default setting AV #

1. Fusing temp. adjust.

ﬂ Enter or select the new value for this set-
ting.

@ Note

O How you do this will depend on which set-

ting you are changing. See the section en-
titled “CHNGING THE USER TOOL

SETTING” on Page 65 for more details.
“DEFAULT FUNCTION SETTINGS”
on Page 69.

B Repeat steps 3 and 4 for all the settings
you wish to change.

Exiting the User Tools menu

n Press the [User Tools]) key.

The copier returns to the ready condition.
& Note
3 You can also press the [ Clear Modes/En-

ergy Saver] key to quit the User Tools
menu.
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USER TOOLS

USER TOOLS MENU TREE

Press the | User Tools | key

Change items with
the[A)/[V]key

Change items with
the[A)/[¥]key

M{ 1. Fusing temp. adjust ‘ 0C ‘

(Default setting)

[#]key

Change items with
the[4)/[V]key

1. Leading edge ‘ +2.0" ‘ = Page 66
= Page 65
2 [#]key — m
2. Trailing edge ‘+Z.O ‘ = Page 66
[#]key
2. Store program i
= Page 26 Y13, Image shift UPDOWN | Trail 0.4" | = Page 66
G#lkey (3 B ackeround setting [Lighter | ke I rage shift LR [Right 0.4" | = Page 66
= Page 65
[#lkey 5. Erase Border ‘ 1.0" ‘ = Page 66
H{#]key 4. Default setting 41k
= Page 66 Siry Magnif. adjustment | Bond Paper: 0.0% = Page 67
Vellum Paper: 0.0% | = Page 67

Film: 0.0%

= Page 67

[#]key

7. Fusing temp. adjust | Bond Paper: 150°C

= Page 68

Vellum Paper: 170°C| = Page 68

H{#]key 5. Initial setting

= Page 69

[#lkey 6. Copy length

Length 1: 80.0"
Length 2: 100.0"
= Page 73

Llkey (7 Roll widh ]

Roll 1: 0"
Roll 2: 0"
Roll 3: 0"
=Page 73

Lol

Magnification Ratio 1: 100%
Magnification Ratio 2: 200%
= Page 74

Change items with
the[A)/[V]key

[#1key 9. Memory copy mode
= Page 74

1. Copy quality setting|

Normal

2. Output setting

Stack

3. Disk formatting

4. Auto Image Density|

For every originals

[#1key,
L

[#]key

[#]key

[#]key

[#]key

[#]key

[#]key

[#]key

[#]key

[#]ke:

[#]key

Film: 150°C = Page 68

1.Image Density ‘ Auto ‘ = Page 69

2. Paper Roll [Roll 1 | = Page 69

M{ 3.Set cutting method ‘ Synchronized ‘ = Page 69
m{ 4.Change zoom inc. ‘ 1% increments ‘ = Page 70
5.Synchr. cut length ‘Yes ‘ = Page 70

6. Image creation ‘ single function ‘ = Page 70

7. Energy saver ‘Level 2 ‘ = Page 70

8. Auto Reset Time ‘ 90 sec. ‘ = Page 71

9. Auto Off Timer ‘ 30 min. ‘ = Page 71
M{ 10. Size mode setting ‘Engineering sizes ‘ = Page 71
11. Copy mode selling‘ 100% ‘ = Page 72

12. Memory copy mode‘ No ‘ = Page 72

13. Pre-scan (Reduction)] No | = Page 72

14. Auto Tray Switching ‘ No ‘ = Page 72
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CHAGING THE USER TOOL SETTING

Adjusting the Fusing
Temperature Temporarily

Follow these steps to temporarily adjust the
fusing temperature. The machine will return
to the default fusing temperature when you
press the [ Clear Modes/Energy Saver ] key or
change paper types. For how to change the
default fusing temperature permanently, the
see “Fusing temp. adjust.” setting on page 68.

i] Press the [User Tools] key.
“1. Fusing temp. adjust.” is displayed.

Default setting AV #

1. Fusing temp. adjust.

E Press the [#] key.
The default fusing temperature is displayed.

AV
0°C

Fusing temp. adjust

B Press the [A [ V] key to adjust the fus-
ing temperature.
e -5 - +5°C(about 1°C steps)

E] Press the [#] key and then press the
[User Tools] key.
“Warming up” is displayed.

@ Note

O When “Ready” is displayed, you can start
copying.

O The [ Temperature Adjustment] indicator
is lit when the fusing temperature is not
+0 °C.

O When you press the [ Clear Modes/Energy
Saver) key or change paper types, the

specified fusing temperature is cleared and
the [ Temperature Adjustment] indicator
goes off.

/O Reference

You can specify the default fusing tempera-
ture. => Page 68, “Fusing temp. adjust.”

Storing a Program

/O Reference
“PROGRAM” => Page 26

Setting background Image
Density

[I Press the [A)[ V] key until “3. Back-
ground setting’” appears.

Default setting AV i

3. Background setting

g Press the [#] key.
The default background image density is dis-
played.

Background setting AV #

2. Lighter

BPress the [A)/[ V] key to specify the
background image density.
* Darker/Lighter

E] Press the [#] key.

@ Note

O To return the copier to the ready condi-
tion, press the [ User Tools ] key.
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USER TOOLS

Changing Default Setting

Margins

You can specify margins in the range of -8.0"
to +8.0" in 0.1" steps.

i] Press the [A)/[ V] key to display “I.
Leading edge” or ‘2. Trailing edge.”

Default setting AV H
1. Leading edge

Default setting AV H
2. Trailing edge

E Press the [#] key.
The margin setting (cut length) is displayed.

Set lead. Edge N. AV#

Set trail. Edge N. AV #

B Press the [A)/[ V] keys to specify the
default margin setting.

E] Press the [#] key.

@ Note

O To return the copier to the ready condition,
press the [ User Tools] key.

Image Shift

You can specity shift widths in the range of
-8.0" to +8.0" in 0.1" steps.

nPress the [A)/[ V] key to display “3.
Image shift UP/DOWN” or ‘4. Image
shift L/R.’

Default setting AV i
3. Image shift UP/DOWN

Default setting AV #
4. Image shift L/R

B Press the [#] key.
The image shift width is displayed.

Set image shift AV
Trail 0.4"

Set image shift AV
Right 0.4"

B Press [0]) of the[ Number] keys three
times.

E] Press the [A] key for the upward or left
direction, [V] for the downward or
right direction, or press the [ Number]
keys to specify the default shift width.

B Press the [#] key.

@ Note

O To return the copier to the ready condition,
press the [User Tools ] key.

Erase Border

You can specify erasing widths in the range
of 0 to 2.0" in 0.1" steps.

[l Press the [A)/[ V] key until “5. Erase
Border” appears.

Default setting AV #

5. Erase Border
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E Press the [#] key.
The border erasing width is displayed.

[I Press the [ A }/[ V] key until 6. Magnif.
adjustment” appears.

Num./Av —#
1.0"

Erase border

Default setting AV #

6. Magnif. adjustment

B Press the [A)/[ V] key or [ Number]
keys to specify the default erasing width.

[I Press the [#] key.

@ Note

O To return the copier to the ready condi-
tion, press the [ User Tools ] key.

Magnification Adjustment

The magnification ratio for full-size copying
differs depending on the paper characteristics.
In particular, when using large-size paper, you
need adjust the magnification ratio because it
differs widely from the default.

F] Preparation

O You can adjust the full-size reproduction
ratio by +/-3 % in 0.1 % steps. You can
specify aratio separately for the length and
width of paper of three types: bond paper,
vellum paper, and film.

O When you enlarge/reduce copies by chang-
ing the default reproduction ratio, the new
ratio is regarded as 100 %.

O If you change the default reproduction ra-
tio for each paper type, the specified ratio
is used for [ Vellum Paper ) or [ Film ] when
selecting these media types.

B Press the [#] key.
The reproduction ratio for the bond paper
width is displayed.

AV #
+0.0%

Mgnif. adjust.
Bond paper width

B Press the [AY[ V] key to specify your
desired reproduction ratio.

E] Press the [#] key.
The reproduction ratio for the bond paper
length is displayed.

Mgnif. adjust. AV i

Bond paper Length +0.0%

BPress the [A)/[ ¥ Jkey to specify your
desired reproduction ratio.

E Press the [#] key.
The reproduction ratio for the vellum pa-
per (translucent paper) width is displayed.

AV #
+0.0%

Magnif. adjust.
Vellum width

@ Note

O To return the copier to the ready condi-
tion, press the [ User Tools ] key.

O To change the full-size reproduction ratio
for vellum paper, repeat steps [2] to [6].

O To change the full-size reproduction ratio
for film, repeat steps [2] to [6].
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Fusing Temperature
Adjustment

i] Press the [A)/[ V] key until 7. Fusing
temp. adjust” appears.

Default setting AV 4
7. Fusing temp. adjust +0.0 °C
Fusing temp. adjust AV #
Bond Paper +150 °C

E Press the [#] key.
The fusing temperature for “Bond Paper’
is displayed.

)

B Press the [A)[ V] key to select a fus-
ing temperature.
e 150°C/160°C/170°C

E] Press the [#] key.
The fusing temperature for “Vellum Paper’
is displayed.

@ Note

O When you press the [ User Tools] key,
“Please wait” is displayed. When “Ready”
appears, you can start copying.

O To specify the fusing temperature for vel-
lum paper (translucent paper), repeat steps
[2] to [4].

(145°C/160°C/170°C)

O To specify the fusing temperature for film,
repeat steps [2] to [4].
(150°C/160°C/170°C)

s
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Initial Setting

A Reference

O The following procedures begin assuming
that the display shows the initial settings
menu. For how to bring up this menu, and
exit the User Tools menu, see “ACCESS-
ING THE USER TOOLS OVERVIEW.”
=> Page 63

Image Density

You can set the default image density setting
to one of the following: Manual Image Den-
sity, Auto Image Density, and Photo. You can
also use [ Darker] and [Lighter] to adjust the
density more subtly.

& Note

O To specify Manual Image Density, make
sure that both the [Photo] and [ Auto Im-
age Density ] indicators are not lit. Then
use the [Darker) or [Lighter] key to se-
lect the density you require.

i] Press the [A}[ V] key until 1. Image
Density” appears.

Initial setting AV i

1. Image Density

E Press the [#] key.

B Press the Image Density key to select
your desired image density.
Manual Image Density/Auto Image Den-
sity/Photo (you can also use the [ Darker]
or [ Lighter ] key to adjust the density more
subtly.)

[I Press the [#] key.

Paper Roll

You can set the default paper tray(the third one
is optional).

@ Note

O To specify manual paper feed, make sure
that the [ 11€5], [21€], and [31€5] indica-
tors are not lit.

[I Press the [A)/[ V] key until “2. Paper
Roll” appears.

Initial setting AV #

2. Paper Roll

g Press the [#] key.

B Press the Paper Roll key to select your
desired paper tray.
1/2/3 (the third tray is optional)/Manual
Feed

E] Press the [#] key.

Set cutting method

You can set the default paper cut method to
Synchro Cut or Preset Cut. For Preset Cut, you
can set the default cut length to one of the
lengths shown in the table below.

@ Note

O The Preset Cut lengths that can be selected
differ depending on whether the paper size
mode is Engineering sizes or Architecture
sizes.

Engineering
44.0"134.0"22.0"|17.0" | 80.0"[{100.0"
Cut length

Architecture
48.0"136.0"(24.0"|18.0"| 80.0"|100.0"

Cut length

*1: A value specified for “Length 1 of Copy
length (=> Page 73).

*2: A value specified for “Length 2” of Copy
length (=> Page 73).

69



| NN T « [N T

70

USER TOOLS

A Reference
Size mode setting => Page 71

i] Press the [A)/[ V] key until “3. Set cut-
ting method” appears.

Initial setting AV #

3. Set cutting method

E Press the [#] key.
E] Press the [A)/[ V] key to select your
desired cut method.

* Synchronized/Std. size cut

[I Press the [#] key.

Change zoom inc.

You can set the reproduction ratio zoom in-
crement to 1 or 0.1 %.

i] Press the [A)/[ V] key until “4. Change
zoom inc” appears.

[I Press the [A}/[ V] key until 5. Synchr.
cut length” appears.

Initial setting
5. Synchr. cut length

AV #

g Press the [#] key.

BPress the [A)/[ V] key to choose
whether to display cut paper lengths.
e No/Yes

E] Press the [#] key.

Image creation

You can choose whether multiple edit func-
tions can be used together.

n Press the [A)[ V] key until “6. Image
creation” appears.

Initial setting AV #

6. Image creation

Initial setting AV #

4. Change zoom inc.

E Press the [#] key.
E] Press the [A)/[ V] key to select your
desired zoom increment.

¢ 1% increments/0.1% increments

[I Press the [#] key.

Synchr. cut length

You can choose whether to have paper cut
lengths shown on the panel display when copy-
ing with Synchro Cut.

g Press the [#] key.
BPress the [A])/[ V] key to choose
whether functions can be used together.

e single function/combined function

E] Press the [#] key.

Energy saver

You can set the Energy Saver mode to one of
two levels:
e Level 1: The machine returns to the ready
condition paper after about 1 minute.
¢ Level 2: The machine returns to the ready
condition after about 3 minutes. This
conserves more power than Level 1.
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i] Press the [A)/[ V] key until “7. Energy
saver” appears.

[I Press the [A)/[ V] key until “9. Auto
Off Timer” appears.

Initial setting AV

7. Energy saver

Initial setting AV i

9. Auto Off Timer

E Press the [#] key.

B Press the [ A }/[ V] key to select your the
Energy Saver level
. Level 1/Level 2

E] Press the [#] key.

B Press the [#] key.

B Press the [A)/[ V] key to select the de-
sired Auto Off Time.
e 15/30/45/60/75/90/105/120 minutes

E] Press the [#] key.

Auto Reset Time

Size mode setting

You can select the interval after which the
machine resets copy mode automatically af-
ter your copy job is finished, or turn off Auto
Reset completely.

i] Press the [A)[ V] key until 8. Auto
Reset Time” appears.

Initial setting AV i

8. Auto Reset Time

a Press the [#] key.

B Press the [A)/[ V] key to select your
desired auto reset time.
e — (Does not reset)/30/60/90/120/150/
180/210/240/270 seconds

!] Press the [#] key.

Auto Off Timer

You can select an interval after which the ma-
chine turns itself off automatically after your
copy job is finished.

You can select Engineering or Architecture
sizes for original and paper sizes.

n Press the [A)[ V] key until “10. Size
mode setting” appears.

Initial setting AV #

10. Size mode setting

B Press the [#] key.
B Press the [A)/[ V] key to select A or B
sizes

» Engineering sizes/Architecture sizes

E] Press the [#] key.
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Copy mode setting

Pre-scan (Reduction)

You can select the copy mode to 100 %, Auto
Paper Select, and Auto Reduce/Enlarge.

i] Press the [A)/[ V] key until “11. Copy
mode setting’”’ appears.

Initial setting AV

11. Copy mode setting

E Press the [#] key.

E] Press the [A J/[ V] key to select the copy
mode.
* 100 %/Auto Paper Select/Auto Reduce/
Enlarge

E] Press the [#] key.

Memory copy mode

You can determine whether the machine starts
in the Memory Copy mode ([ Memory Copy ]
is lit) when you turn on the power or exit the
Energy Saver mode.

(The Memory Unit is required.)

i] Press the [A)/[ V] key until “12.
Memory copy mode” appears.

Initial setting AV #

12. Memory copy mode

E Press the [#] key.

B Press the [A)/[ Y] key to choose
whether the machine enters the Memory
Copy mode.

* Yes/No

E] Press the [#] key.

When using Synchro Cut, this function scans
an original length and cuts copy paper by re-
duced copy length.

ﬂPress the [A)/[ V] key untill”’13.Pre-
scan(Reduction)”” appears.

Initial setting AV #

13. Pre-scan (Reduction)

B Press the [#] key.

BPress the [A])/[ V] key to choose
whether to scan an original length.
* Yes/No

E] Press the [#] key.

Auto Tray Switching

If roll paper runs out during a copy run, the
machine selects another roll of the same size
automatically to continue copying.

nPress the [A)/[ V] key until’’14.Auto
Tray Switching” appears.

Initial setting AV i

14. Auto Tray Switching

B Press the [#] key.

B Press the [A)/[ V] key to choose
whether to select another roll of the same
saize.
¢ Yes/No

E] Press the [#] key.
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Copy Length

Roll Width

i] Press the [A)/[ V] key until “6. Copy
length” appears.

User length AV i
6. Copy length
E Press the [#] key.
“Length 17 is displayed.
Set copy length N./AV #
Length 1 80.0"

E] Press the [A)/[ V] key or [ Number]
keys to specify your desired length.

@ Note

O If you have entered a wrong number, use
the [A)/[ Y] key or [ Number] keys to
enter the correct one.

[I Press the [#] key.
“Length 2” is displayed.

@ Note

O To return the copier to the ready condition,
press the [ User Tools] key.

O By default, lengths 1 and 2 are set to the
following values:
* Length 1 80.0"
e Length 2 100.0"

O To specify a value for “Length 2,” repeat
steps [2] and [3].

Tips

O You can also enter a length approximate to
the length you require with the [ Number )
keys, then adjust it with the [A }/[ V] key.

You can specify a roll width regardless of roll
paper widths. When using non-standard size
roll paper, specify a roll width that matches
the roll paper width.

& Preparation

O If you specify “0,” the machine automati-
cally detects the size (as one of the A or B
sets of paper sizes).

ﬂPress the [A)/[ VY] key until “7. Roll
width” appears.

User Tools AV 4

7. Rool width

B Press the [#] key.
“Roll 17 is displayed.

Set roll width
Roll 1

N. /AV #

BPress the [A)/[ V] key or [Number]
keys to specify a roll width for Roll 1.

@ Note

3 You can specify roll widths in the range of
17.0" ~ 36.0" in 0.1" steps.

O If you have entered a wrong number, use
the [A)/[ VY] key or [ Number] keys to
enter the correct one.

E] Press the [#] key.
“Roll 2” is displayed.

@ Note

O To return the copier to the ready condition,
press the [ User Tools] key.

O To specify a roll width for Roll 2, repeat
steps [3] and [4].

0 When the optional paper tray is added to
your machine, specify a roll width for Roll
3 in the same way.

73



| NN T « [N T

USER TOOLS

Setting Preset Reduce/En-

large
i] Press the [A)[ V] key until “8. Preset
R/E” appears.
User setting AV i

8. Preset R/E

E Press the [#] key.
“Magnification Ratio 17 is displayed.

Reset R/E N. /Av #
Magnification Ratio 1 100%

B Press the [A)/[ VY] key or [ Number]
keys to specify your desired magnifica-
tion ratio.

@ Note

O If you have entered a wrong number, use
the [ A }/['V ] key or [Number] keys to en-
ter the correct one.

E] Press the [#] key.
“Magnification Ratio 2” is displayed.

@ Note

O To return the copier to the ready condition,
press the [ User Tools] key.

O By default, magnification ratios 1 and 2 are
set to the following values:
* Magnification Ratio 1 100 %
* Magnification Ratio 2 200 %

O To specify a value for “Magnification Ra-
tio 2,” repeat steps [3] and [4].

74

Memory Copy
& Note

0 When specifying the following function
settings, the Memory Unit is required:

Copy quality setting(Normal/
Fine)

“Memory Copy” allows you to change the
resolution at which the copier scans originals.
Select “Normal” to scan ordinary originals.
Select “Fine” when scanning originals con-
taining small numbers or characters, fine
graphics, photographs, or maps.

& Preparation

O Scanning with “Fine” takes up more
memory space than with “Normal”.
=> Page 84, “OPTIONS”

ﬂPress the [A)/[ V] key to display “I.
Copy quality setting”. Then press the
[#] key.

Memory copy AV i
1. Copy quality setting

B Press the [A)/[ V] key to display your
desired setting.

AV
1. Normal

@ Note

1. Normal (default)
2. Fine

B Press the [#] key.

@ Note

O To return the copier to the ready condition,
press the [User Tools] key.
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Output setting(Sort/Stack)

Auto Image Density

You can specify how to deliver copies when
copying with “Memory Copy.”

I] Press the [A)/[ V] key to display ‘2.
Output setting”. Then press the [#] key.

Memory copy AV #

2. Output setting

E Press the [A)[ V] key to display your
desired setting.

AV #
1. Sort

@ Note

1. Sort
2. Stack (default)

B Press the [#] key.

@ Note

O To return the copier to the ready condition,
press the [ User Tools] key.

When scanning originals made up of more
than one page using Memory Copy and Auto
Image Density, you can choose whether the
copier detects the image density for every
original or only for the first original (first time).

[l Press the [A)/[ V] key to display “4.
Auto Image Density” Then press the [#)
key.

Memory copy AV #

4. Auto image Density

B Press the <[A)/[ V] key to display your
desired setting.

AV

1. For First orig. only

@ Note

1. For first orig. only
2. For every originals (default)

B Press the [#] key.

@ Note

O To return the copier to the ready condition,
press the [User Tools] key.
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USER TOOLS

WHAT YOUR SERVICE

REPRESENTATIVES CAN CHANGE

Your service representative can change some
functions to meet your needs and make the
copier easier to use. Please contact your ser-
vice representative for more details.

The functions that can be changed are shown
below.

Changing the Maximum Original
Length When Making Multiple
Copies

You can specify a maximum original length
between 48" and 60" for making multiple cop-
ies.

Changing the Original Delivery
Direction

Originals are delivered from the back of the

copier after copying. You can change this func-

tion so that they are delivered from the front

of the copier. When Memory Copy is selected,

however, originals are delivered only from the

back of the copier.

? Limitation

O You cannot make multiple copies when
delivering originals from the front of the
copier.

O Remove the original reverse guide when
delivering originals from the front of the
copier.

Changing the Number of Levels
for Copy Image Density Adjust-
ment

You can change the number of image density
adjustment levels from 13 to 7.



DO’S AND DON'TS

A\ CAUTION:

e When you move the machine, unplug the power cord from the
wall outlet to avoid fire or electric shock.

e When the machine is not in use for a long time, unplug the power
cord.

O Do not touch areas on or around the fusing unit. These areas get hot.

O After making copies continuously, you may feel the original table surface is heated. But this
is not a malfunction.

O You may feel warm around the ventilation hole. This is caused by exhaust air, and not a
malfunction.

3 Do not turn off the main switch while copying. When turning off the main switch, make sure
that copying is completed.

O The machine might fail to produce good copy images if there should occur condensation
inside caused by temperature change. To avoid this condition, the machine has the anti-
condensation feature. When you turn on the anti-condensation heater, the machine keeps
itself warm even after you turn off the main switch.

O Do not open the front or right side cover while copying. If you do, misfeeds might occur.

3 Do not move, slant, or vibrate the machine while copying.

O Do not use for other OA machines paper on which you copied with this machine. Otherwise,
a fault might occur.

O Take a note of your machine settings.

If you operate the machine improperly or a failure occurs on the machine, your machine
settings might be lost. Be sure to take a note of your machine settings.

O Supplier shall not be liable for any loss or damages resulting from a failure on the machine,
loss of machine settings, and use of the machine.

O Use the machine in a well-ventilated location. When you are using the machine, ozone is built
up, but does not affect the human body since its amount is very small. However, your working
room might be filled with a bad smell if you use the machine for a long period of time or make
a large number of copies without good ventilation. You should ventilate your working room to
keep it comfortable.
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REMARKS

PLACING, MOVING,
AND DISPOSING OF YOUR MACHINE

When you move the copier if your office changes the equipment layout or moves to another
location, follow the precautions shown below.

Moving the Machine

A\ CAUTION:
% e When you move the machine, unplug the power cord from the

wall outlet. Otherwise, the cord might be
damaged causing a fire or electric shock.

* When you move the machine, contact your service representative. This is a charged work.

Where to Put the Machine

A\ CAUTION:
e Keep the machine away from humidity and dust. A fire or an
electric shock might occur.
e Do not place the machine in an unstable location or on a slope.
Otherwise, the machine might move or fall causing personal in-
jury.

A\ CAUTION:
0 e After you move the machine, fix it in place with the caster fixture.

Otherwise, the machine might move or fall causing personal in-
jury.

Avoid placing the copier in the following locations. If you place it in an improper location, you
cannot make copies normally or a failure might occur.
O Excessively cold and dry or hot and humid locations
The recommended temperature and humidity are as follows.
e Temperature: 38 - 52°F
e Humidity: 15 - 85%
O Locations exposed to direct sunlight
O Locations near a heater, air conditioner, or humidifier.
O Locations where the machine might be subjected to frequent strong vibration
O Locations without good ventilation
O Locations near an oil heater or equipment which generates ammonia (e.g., a diazo copier)
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PLACING, MOVING, AND DISPOSING OF YOUR MACHINE

O Dusty areas
O Unstable floors or bases
* Place the machine in a flat location. The machine must be level within 0.13 degrees both
front to rear and left to right.
¢ Place the machine on a stable floor. When placing the machine on a base, choose a strong,
level one such as a dedicated table larger than the machine’s area.

Cautions on Jamming
When you place the machine near another electronics equipment, they might adversely affect
each other.
In particular, if the machine is adjacent to a television or radio, it might suffer their noise.
In this case, take the following actions:
» Keep the machine away from the television or radio.
* Use a different outlet separately for the machine and these products.
* Reorient the television or radio antenna.

For Customers Using an Ultrasonic Humidifier

If you use tap or well water for an ultrasonic humidifier, impurities contained in the water become
white powder and settle on the internal parts of the copier causing copies or copy paper to be dirty.
In particular, when you use the humidifier continuously for a long time, a humidifier demineral-
izer is recommended.
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Access to Machine

Leave enough space around the copier. This space is necessary for you to operate the copier or a
customer engineer to work. When the copier is equipped with options, consult a customer engi-

neer about the space.

Standard setting

30cm ‘
-—

§,I — Front 32.0"

‘ 4|=- ] soom Rear 12.0"
Left 12.0"

\ / Right 20.0"

CE0S0100

Power Connection

/\ WARNING:

S

Connect the machine to a power source meeting the specifica-
tions given. Avoid overloading an outlet with too many power
cords. Otherwise, a fire or electric shock might occur.

Avoid using an extension cord.

Do not damage, break, or make any modifications to the power
cord. The power cord will be damaged if you set heavy items on
it, pull it, or twist it excessively, and a fire or electric shock might
occur.

Do not plug in or unplug the power cord with wet hands. Other-
wise, an electric shock might occur.

N\ WARNING:

0"

Make sure that the wall outlet is near the machine and easily ac-
cessible.

A\ CAUTION:

3

When you unplug the power cord from the socket, hold the cord
by the plug. Do not pull the cord. Otherwise, the cord might be
damaged causing a fire or electric shock.

80



| NN T » [N 7T

PLACING, MOVING, AND DISPOSING OF YOUR MACHINE

/\ CAUTION:
% e When the machine is not in use for a long time, unplug the power

cord.

0 When you unplug the power cord, the anti-condensation and dehumidification heaters are
turned off.

O Plug the power cord in a wall outlet directly and firmly.

Disposing of the Machine

If you want to dispose of the machine, contact your local dealer or service representative.
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REMARKS

CLEANING YOUR MACHINE

If the exposure glass or original feed roller is
dirty, you cannot make copies as you want.
Clean them if you find them dirty.

Cleaning the Machine

Wipe the machine with a soft, dry cloth. If
contaminants remain, wipe it with a wrung,
damp cloth. If you cannot remove them with
the water, wipe the machine with a neutral
detergent.

After wiping the machine with a damp cloth,
wipe it with a dry cloth to remove the water.

1k Important

O Do not use chemical cleaner or organic sol-
vent, such as thinner or benzine. If they
get into the machine or melt plastic parts,
a failure might occur.

O The internal parts of the machine should
be cleaned by your service representative.

Cleaning the Original Cover

Cleaning the Exposure Glass

Cleaning the Original Feed Roller
Wipe the original feed roller while rotating the
part indicated by (1) in the illustration below.




SPECIFICATIONS

Configuration Console

Photosensitivity Type OPC drum

Copy Process Dry electrostatic transfer system
Development Dry two-component magnetic brush system
Fusing Heating roll system

Scanning Original moving over a fixed fiber optics array
Originals Sheet

Original Size E (36"x48"[J-A (9"x 12"}, 85" x 11"[;)
WxL) 8.5"x 11" 36" x 197"

Resolution 400 dpi

Gradation Process 32 values

Warm-up Time Within 10 minutes

First Copy Time Within 22 seconds

(D, Roll 1, Manual Image Density)

Copying Speed (Full-size Copying)

1.9 copies/minute (E (36" x 48")[}))
3.5 copies/minute (C (18" x 24")7)

Maximum Original Size

36" x 197"

Reproduction Ratio

Full size: 100 % +/- 0.5 %

Enlarge: 129 %, 259 %, 314 % (for Engineering sizes)
133 %, 267 %, 400 % (for Architecture sizes)

Reduce: 25 %, 32 %, 50 %, 65 % (for Engineering sizes)
25 %, 33 %, 50 %, 67 % (for Architecture sizes)

Zoom: 25 - 400 % (in 1 % or 0.1 % steps)

Non-reproduction Area

Leading edge: 0.2"+/- 0.16" or less

Trailing edge: 0.16" or less (excluding a cut error)
Left edge: 0.08" +/- 0.08" or less

Right edge: 0.08" +/- 0.08" or less

Paper Feed

2 roll feeders/manual feed table (an optional roll feeder
can be added)

Series Copying

20 copies (maximum original length: 48.0")

Power Source

North America: 120V, 60 Hz, 13 A

Power Consumption

1.5 kW at the maximum

Dimensions 53.3"%x25.0"x 44.6"
(WxDxH)

Full System Area 53.3"x49.2"

(W x D, Including the Extended Parts)

Weight 613 1b
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SPECIFICATION

OPTIONS

Roll Feeder Type 7030D
The roll feeder you can set as the third paper tray.
O Weight * 10kg
(This includes the roll spool and excludes the parts to be attached to the main unit.)
O Dimensions (W x Dx H) ¢ 1,025 x 185 x 340 mm

Memory Unit Type 7030D
Allows you to add the Memory Copy function to the copier.
If you need SIMM (Memory) or HDD, please consult your sales or service representatives.
O Memory Capacity
Standard: 16 MB (64 MB at the maximum. 2-GB HDD can be added.)
O Resolution
400 dpi
O Gradation Process
Normal (2 values)/Fine (4 values)
O Coding System
QM-Corder
O Maximum Number of Originals That Can Be Stored in Memory
Maximum number of originals: 127

A1 (black proportion: 4 %)

16 MB | 32 MB | 48 MB | 64 MB

Normal 32 64 96 127
Fine 11 22 33 44

* When using the HDD, the maximum number of originals that can be stored is 127 both for
Normal and Fine.

O3 First Copy Time
36 seconds/D (36" x 245

O Copying Speed (Full-size Copying)
3.0 copies/E (36" x 48" [J

O Power Source

Supplied from the main unit
Speed (Full-size Copying)

3.0 copies/E (36" x 48") B

1k Important

O When you want to mount SIMM or an HDD on the machine, ask your service representative
to do the work. If you mount or modify parts by yourself, the warranty is not applied to the
machine.
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INDEX

A

anti-humidity heater, 6
architecture sizes, 3,69
auto enlarge, 22

auto image density, 18, 75
auto off timer, 71

auto paper select, 21

auto reduce, 22

auto reset time, 71

auto start, 27

auto tray switching, 72

B

background setting, 65
black lines, appear, 44
bond paper, 4

c

carrier sheet, using, 15
change zoom inc., 70
changing roll paper, 48
combination chart, 40
copy catch tray, 9

copy guides, 9

copy length, 73

copy mode setting, 72
copy quality setting, 74
copy, dirty, 45

copy, sampling, 39
copying with memory unit, 11
copying, 10

D

darker/lighter, 18

density, 18

directional magnification, 32
do’s and don’ts, 77

E

energy saver mode, 27
energy saver(default), 70

*

enlarge, 29

erase border, 33

erase border(default), 66
engineering sizes, 3,69

F
film, 4

fine/normal, 74

fusing temperature temporarily, 65
fusing temperature, 25, 65, 68

H
humidity, 6, 78

|

image creation, 70

image density(default), 69

image shift, 37

image shift(L/R)(default), 66

image shift(UP/DOWN)(default), 66
interrupt, 28

J
jams, 57
jams occur frequently, 46

L

leading edge margin, 35

leading edge margins(default), 66
lighter/darker, 18

M

machine, cleaning, 82
machine, disposing, 81
machine, moving, 78
magnification adjustment, 67
“maintenance due”, 42
margins, 35

memory copy, 11

memory copy mode, 72
memory unit, 84
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message, appears, 42
mirror, 34
Misfeed(s):A, 60
Misfeed(s):B, 57
Misfeed(s):C, 57
Misfeed(s):D, 57
Misfeed(s):P, 59
Misfeed(s):S, 58

N

negative/positive, 34
normal/fine, 74
“now adding toner”, 42

(0]

original guide, 14
original reverse guide, 9
original, dark/light, 18
originals, 1

output setting, 75

P

paper roll width, 73

paper roll(tray), 69

paper tray select, 21

paper tray, auto switching, 72
paper, recommended & non-recommended, 3
paper, roll, 4

paper, translucent, 4

photo, 18

placing copier, 78

“please call service”, 42
“please wait”, 41
positive/negative, 34

power connection, 80
pre-scan(reduction), 72
preset cut, 23

preset reduce/enlarge, 29, 74
preview copy, 39

program, 26

R

recalling program, 26
reduce, 29

roll feeder, 84
roll width, 73

S

scanning area, 3

set cutting method, 69
size mode setting, 71
sort, 11

sort/stack, 75
specifications, 83
stack, 11

stack/sort, 75

storing program, 26
synchr. cut length, 70
synchro cut, 23

T

temperature, fusing, 25, 65, 68
toner tank full, 51

toner, adding, 7

toner, adding, 48

toner, used, 51

trailing edge margins(default), 66
trailing edge margin, 35
troubleshooting, 41

U

user tools, 63

v

variable cut, 23
vellum, 4

w

“warming up”, 41
waste toner, 51

Y4

zoom, 31

A741



APPENDIX

PROGRAMMING/RECALLING IMAGES
(MEMORY UNIT AND HDD REQUIRED)

You can store original images in programs 6-
10 and recall them at will with the[ Recall Pro-
gram ] key.

E] Preparation

O The HDD is an option for the Memory
Unit. For more information, contact your
service representative.

0 Once you store an image, it is not cleared
even when you turn off the main switch.

O If you store an image in a program that
already contains an image, the old image
will be overwritten. Be sure to make a
memo of stored images.

O To check whether a program already con-
tains an image, use the [Recall Program )
key.

0 The store/recall image feature is only avail-
able when the [ Memory Copy ] indicator
is lit.

O Before you store an image, select an im-
age quality level (Normal/Fine) appropri-
ate to the type of your original. Select
“Fine” when your originals contain small
characters, fine graphics, photographs, or
maps.

1k Important

3 Do not turn off the main switch while you
are storing/recalling an image or making a
copy. Otherwise, the hard disk might be
damaged causing a malfunction.

O When you turn off the main switch with
the hard disk attached to the machine, wait
for about 20 seconds before you turn it on
again. Otherwise, the hard disk might be
damaged causing a malfunction.

Programming an Image

[I Make sure that the Memory Copy indi-
cator is lit.
If it is not lit, press the [Memory Copy]
key.

Ready(NormaleStack) 1

g If you want to change the image quality
level, select “Normal” or ‘“Fine.”

A Reference

=> Page 74, “Copy quality setting”

E]Specify a reproduction ratio, margins,
editing, or any other function you re-
quire. Use the [Lighter J[Darker] key
as necessary.

E]Press the [User Tools] key.

User Tools AV #

2. Store program

B Press the [A)/[ V] key to show 2. Store
program” on the panel display. Then
press the [#] key.

E Press the [A)[ V] key to select the pro-
gram (6 - 10) in which you wish to store
the image. Then press the [#] key.

Store program AV #

Ready to Preview copy
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ﬂTo store the image, press the [#] key.

Store Program #
Ready to Preview copy

Making a Preview Copy
& Note

O You can use the following three functions
to make a preview copy when you program
an image:

O Function Preview: Allows you to check
Mirror, Positive/Negative, or other func-
tions.

O Image Density Preview: Copies the lead-
ing portion of an original with seven levels
of image density on a 20-mm basis.

O Full Preview: Makes a copy just as you
would when recalling a stored image.

© Press the [Preview Copy] key.

@ Press the [ A )/[ V] key to select one of the

preview modes.

® Press the [#] key.

O Set your original.

The copier starts copying.

@ Note

0 When the copy run starts, the original is
fed a little and delivered back to position.
Then it is kept on the original table.

O After preview copying, press the [# Jkey if
you want to start storing the entire original
with the these copy settings.

O To cancel storing the original, press the
[ Clear Modes ] key and remove the origi-
nal.

m Set your original.

Set Original

@ Note

O Move the left original guide so they match
the original width. The machine detects
the original width (841, 594, or 420 mm)
based on the left guide position.

Now scanning

Store program
Program stored.

@ Note

O Do not move the original guides until “Pro-
gram stored.” is displayed.

ﬂPress the [User Tools] key.
The copier returns to the ready condition
for Memory Copy.

Recalling a Programmed
Image

[I Make sure that the Memory Copy indi-
cator is lit.
If it is not lit, press the [Memory Copy]
key.

Ready(NormaleStack) 1

BEnter the number of copies required
with the [ Number] keys.

ﬂPress the [Recall Program] key.
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ﬂ Press the [A)/[ V] key to select the pro-
gram (6 - 10) you want to recall. Then
press the [#] key.

Recall Program AV i
Program 6 841mm

@ Note

O The width of the original detected during
scanning (841, 594, or 420 mm) is shown
on the screen.

BSelect a paper tray based on the origi-
nal width shown on the screen.

ETO start copying, press the [#] key.

Press # for opying
100% 841mmX ----

@ Note

O The copier uses copy settings that were
previously stored to make copies. You can-
not specify additional function settings, but
you can change paper tray or select Syn-
chro Cut/Preset Cut.

T You can also check the stored copy set-
tings by using the [Preview Copy] key
before copying.

HTO finish copying, press the [ Clear
Modes/Energy Saver] key.
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Disk formatting

An image other than those stored in the HDD
might be copied if you turn off the main switch
or unplug the power cord while scanning an
original with Memory Copy. In this case, you
need to format the HDD again.

& Preparation

O When you format the hard disk, stored
originals are cleared.

O Tt takes about 20 minutes to format the hard
disk. Once you start this operation, you
cannot cancel it.

O While formatting the hard disk, you can-
not use the Memory Copy function, but can
perform normal copy jobs which do not
require the hard disk.

O To enter to Memory copy mode, see P.64.

i] Press the [A)/[ V] key to display “3.
Disk formatting”. Then press the [#]
key.

Memory copy AV i
3. Disk formatting

E Press the [A)[ V] key to display your
desired setting.

AV #
1. Format disk?

@ Note

1. Format Disk? (default)
2. No

B Press the [#] key and then press the
[User Tools] key.
“Now formatting HDD” is displayed.
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Preface

The Repro System is designed to connect a large format digital copier
to a computer to be used as a plotter controller system.

This handbook describes how to use the software and applications
included in the Repro System.

Please refer to the instruction handbook of the large format digital
copier for information about the installation and use of the copier.

Notes
* The contents of this handbook is subject to change without notice.

¢ No part of this handbook may be reproduced or transmitted, in any form,
without prior written permission.

Microsoft Windows NT is a registered trademark of Microsoft Corporation in the
USA.

Pentium Pro is a registered trademark of Intel Corporation in the USA.
AutoCAD is a registered trademark of Autodesk Inc. in the USA.

All other brand names and trade names used in this handbook are trademarks
or registered trademarks of their respective owners.
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» Overview

This section provides an overview of Repro System.

1.1 Features

1.2 System configuration
1.3 Product components
1.4 System requirements



Overview

1. Overview

1.1 Features
The Repro System provides the interface between a large digital copier (hereafter
called “copier”) and computers to function as a plotter controlier system.

The Repro System enables printing of multiple TIFF or HPGL/2 files at a time by
inserting files to be printed into a set. Also, the traditional tasks of plotting and
collating paper documents can be performed under software control.

With the Repro System, a copier can be used as a scanner. The scanned data is
inserted into a set as TIFF files.

Other features include:
* Easy-to-use Windows NT Graphical User Interface.
* TIFF files and HPGL/2 files can be added to a set.

* By assigning the license, AutoCAD files (DWG, DXF) can also be added to a set
(see 7. License Setup).

* Reports of system usage.

1-2
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1.2 System configuration

The system configuration is shown in Figure 1-1.

The Repro System is to be installed on a computer running Windows NT. When
connected to a copier via a PCl interface cable, a computer running this software
performs as a plotter server. In such a system configuration, this computer is called
the Local Client.

Computers that have this software installed and use the copier connected to the
Local Client are called Remote Clients.

The Local Client also provides Remote Client facilities.

Plotter controller system

Local Client Interface ‘meface Digital copier
reiay da
(Repro System) | ead [ o i e race cable | poB
Windows NT
Remote Client

(Repro System)

Windows NT

Remote Client
(Repro System)

Windows NT

Remote Client
(Repro System)

Windows NT

Figure 1-1 System configuration
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1.3 Product components
1.3.1 Supplied products

The following are supplied with the package.
* CD-ROM (1)

* Interface card

* PCl interface cable

* Relay PCB (2, used during installation)

* Relay cable (used during installation)

* Installation manual

1.3.2 CD-ROM

The supplied CD-ROM contains:
* Repro System (the program for plotter controller)

* LittleBear Driver (the driver which communicates between copier and interface
card)

* Installer (program to install Repro System and the LittleBear Driver)
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1.3.3 Repro System

The Repro System consists of the following four applications:
1. Client
The Client application provides the Repro System’s main facilities. Namely:
* Create a new set.
* Scan files into a set.
* Add files such as TIFF or HPGL/2 to a set.
* Assign pen settings and plotting instructions to each file.
* Change printing order.
* Preview the contents of an image file before printing.
* Assign stamps to be applied to each plot.
¢ Print the requested number of copies of a file within a set.

* Delete a set or files in a set.

2. Admin

The Admin application controls the copier interfacing with the Repro System and
creates reports on the system usage conditions.
On a Local Client this application also administers the license.

3. Stamp

The Stamp application creates stamp files.
Using such files, stamps can be inserted into files in a set.

4. Server

The Server application controls the copier as a plotter/scanner and is installed
only on the Local Client. This application relays print/scan jobs from the Local
Client or print jobs from Remote Clients to the copier.
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1.4 System requirements

The following is the minimum equipment required to use a system with the Repro
System:

* Copier
FW7030D

* Computer
200 MHz Pentium Pro Processor
Microsoft Windows NT 4.0 (Service Pack 3 or higher must be installed)
2 GB Hard Disk
128 MB RAM
PCI Bus
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2 = System Installation

This section describes the installation procedure.

2.1 Connecting the machines
2.2 Installing the Repro System
2.3 Setting the copier

2.4 Checking operation

2.5 Other software
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2. System Installation

Figure 2-1 shows the system installation procedure for the Local Client. See 6.
Network Plotting for the installation procedure for the Remote Client.

Connecting the machines

A

Installing Repro System

Y

Setting the copier

4
Checking operation

Figure 2-1 System installation procedure
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2.1 Connecting the machines

Perform the following steps to install the interface card and connect the machines.
1. Turn the power to both the computer and copier off.

2. Remove the computer cover. Locate an available PCI slot and remove its bracket
and screw.

3. Insert the interface card into the PClI slot by pressing it evenly until it sits correctly
in the slot. Check for correct insertion and secure the card with a screw.

4. Refit the computer cover.

5. Connect the PCl interface cable between the copier and computer.

I 6

| 60

~
/]

6. Turn the power to the computer and copier on and then proceed to 2.2 Installing
the Repro System.
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2.2 Installing the Repro System

1. Start Windows NT and close any unnecessary applications.
2. Insert the supplied CD-ROM into the CD-ROM drive.

3. The Setup screen appears followed by the Welcome screen. Click on the “Next”
button.

4. The Choose Destination Location screen appears.
Click on the “Next” button.

S. The Setup Type screen appears.
Select the connected copier and click on the “Next” button.
Select “Client Software” to install the Repro System on a Remote Client.

6. The Select Components screen appears.
Select all the components under normal circumstances and click on the “Next”
button.

7. The Select Program Folder screen appears.
Click on the “Next” button.
The program group name can be changed to any desired name.

8. The Start Copying Files screen appears.
Click on the “Next” button.

9. The Setup Complete screen appears after installation is completed.
Remove the CD-ROM from the CD-ROM drive and click on the “Finish” button to
restart the computer automatically.
Proceed to 2.3 Setting the copier.

The installation program creates a program item in the Start menu. The program
group name is “Repro System”, which contains three program items called Client,
Admin and Stamp. The plotter driver is installed in the Windows NT Printers folder at
the same time.

When uninstalling the Repro System, files in the C:\Program Files\ Repro System\
Plots directory may be deleted. Move any image files before uninstalling the Repro
System.

no
N
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2.3 Setting the copier

Reset the offline status of the copier to use the Repro System.

Resetting the offline status of the copier
1. Press the added features key on the copier operation panel.

2. Press the mode set keys until the message “10. CONTROLLER MODE” appears.

e ————————— O
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10. CONTROLLER MODE
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3.

4.

Press the enter key.
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Press the mode set keys until the message “2. EXIT OFF LINE” appears.

CONTROLLER MODE

2. EXIT OFF LINE

5. Press the enter key.
6. Press the mode set keys until the message “1. OFF LINE RELEASE” appears.

7. Press the enter key.

The offline status is reset and the on-line indicator on the operation panel turns
on.

. Press the added features key. The “READY TO COPY" message appears on the

display of the operation panel.
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The copier cannot be controlled via the copier operation panel while resetting the
offline status. To control the copier via the operation panel, first press the on-line key
to turn the on-line indicator off.

The copier is in the on-line mode (the on-line indicator is on) after the offline status
has been reset. The copier automatically returns to the on-line mode if no copy is
made for a certain period while the copier is offline.

Check the following before starting to control the copier via Repro System or the
copier operation panel.

* Controlling the copier via Repro System

Check if the on-line indicator is on.

If the on-line indicator is off, turn it on by pressing the on-line key.
* Controlling the copier via the copier operation panel

Check if the on-line indicator is off.
If the on-line indicator is on, turn it off by pressing the on-line key.
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2.4 Checking operation

After the machines are connected, the Repro System is installed and the setting of
the copier is complete, check for correct communication between the computer and

copier by performing the following steps.
1. Start Windows NT.
2. Open the Start menu by clicking on “Start” in the task bar.
3. Select “Programs” and “Ricoh Controller”.

wey Progams

Ricoh Contraller

c
9
ot
3
0
X
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Q
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4. Click on “Client”.
The application starts and the project window appears.
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5. Select “Local System Status” from “View” in the menu bar.

Ricoh Cantsoller - Untitled

View

6. The Local System Status screen appears. The “Status-OK” message is
displayed at the top right of the screen if communication is good.

Local System Status

7. Click on the “Close” button to close the screen.

Check the following if the “Status-OK” message is not displayed in the Local System
Status screen.

* Is the copier power turned on?

* |s the copier offline status reset?

* Is the copier on-line indicator turned on?

* Are there any error messages on the copier display?
* Is the PCl interface cable connected correctly?

* Is the interface card inserted correctly?
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2.5 Other software

2.5.1 Virus protection

Since files can frequently be loaded from floppy disks when using the Repro System,
installation of a virus protection application is highly recommended.

2.5.2 Image editor

The Repro System is capable of displaying images. High resolution images can also
be displayed by specifying the image editor in the option setting of Client.
See 3.6 Displaying and editing a plot for details.

Notes

To use the Repro System on a network, ensure that the Windows NT network is
configured correctly.

To use the Repro System locally where no network adapter is installed, configure it
as follows.

1. Open the control panel and click on “Network” to install the network software. If
the network software is already installed, proceed to step 2. Restart Windows NT
after installation.

2. Open the control panel, click on “Network” and select the Adapter tab.

3. Click on the “Add” button and select MS Loopback Adapter. Select Ethernet
802.3 for the frame type.

4. Insert the Windows NT CD-ROM into the CD-ROM drive if requested.
5. Restart the computer.
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3 = Using Client

This section describes how to use Client.

3.1 Starting and closing the application
3.2 Creating and saving a project file
3.3 Sets/members tree

3.4 Creating and deleting a new set
3.5 Inserting and deleting a plot

3.6 Displaying and editing a plot

3.7 Inserting and deleting a stamp

3.8 Editing a stamp

3.9 Inserting and deleting a pen set
3.10 Changing the order of the sets/members tree
3.11 Printing

3.12 Scanning

3.13 Setting properties

3.14 Setting options

3.15 Default settings
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3. Using Client

The Local Client and Remote Clients provide the same facilities except that Remote
Clients do not provide a scanner facility.

3.1 Starting and closing the application
3.1.1 Starting the application

Perform the following steps to start the application.
1. Click on “Start” in the task bar to open the start menu.
2. Select “Programs” and then “Repro system”.
3. Click on “Client”.

The application starts and the project window appears.

% Bogans

B2 Ricoh Contoler
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3.1.2 Project window

This section describes the project window displayed when starting Client.

@ Menu bar. @

(@ Toolbar.

(® Sets/members tree of a project.

(@ Buttons for printing/scanning.

(® Buttons to change the placement of set members.

(® Box in which a plot thumbnail is displayed.

@ Box in which a message indicating Client activities is displayed.

Status bar. Displays information about the menu item indicated by the mouse.
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3.1.3 Select the units system

Perform the foliowing steps to select the units system used in the application.
1. Click on “Tools” in the menu bar to open the Tools menu.
2. Click on “Options”.

Ricoh Controller - Untitled.

- Bptions... -

3. Select the Preferences tab, then the units system to be used in “Units” (see
3.14.2 Preferences tab).
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3.1.4 Closing the application

Perform the following steps to close the application.
1. Click on “File” in the menu bar to open the File menu.
2. Click on “Exit". |
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3.2 Creating and saving a project file

3.2.1 Creating a new project file

When Client is started, it creates a new project called “Untitied”.
A new project can also be created by either of the following methods:
* Click on “New” and then “Project” from “File” in the menu bar.

» Click on the & button in the toolbar.
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3.2.2 Saving a project file

2. Specify the directory, enter the filename and then click on the “Save” button. A
project is saved as a project file with the “.rfx” extension.

Ricoh Controller projects (%.1fx)

A project file is simply a list of the names of plots added to the sets/members tree; no
images or stamps to be printed are contained in the project file.
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3.2.3 Opening an existing project file

2. Select the project to be opened and click on the “Open” button. The project
window appears.

Ricoh Controller projects [*

%% Ricoh Controiler - 123.fx

= %3 Autocad_drawing_2
. = B STAMPS
: - u$a datetime
23 Foider]
¢ EmPLoTS
i ts Autocad_drawing_1
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3.3 Sets/members tree

The sets/members tree in the project window shows the project file status visually.

Using Client, printing is enabled by adding an image file to the sets/members tree.
The Client application is used for adding a plot, stamp and pen set to and deleting
them from the sets/members tree and for defining print settings.

The figure below is an example of the sets/members tree to which image files and
other items have been added.

@ sharp_penset
=150 STAMPS

‘ala datetime

PLOTS

) centrifuge_1

= Autocad_drawing_1
=-§l sTAMPS
i By flenamepath
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(D Project
Displays the project filename.

(@ Set
One per project.
A project can be compared to a box to which a plot, stamp and pen set are
added. Multiple plots inserted in the set can be printed at one time.

® Plot

An image file added to the set. Print and other settings can be defined for each of
the inserted plots. Data from scanning a hard copy can also be added as a plot.
See the appendix for a list of the acceptable file formats.

(@ Pen set
Used when selecting pens for printing: can be set when a plot is a vector file
format.

(5) Stamp
Useful for printing the date and operator names over the plot file image. Since

stamps are stored independently as stamp files, the contents of a stamp can be
modified without affecting a plot.

(& Member
Each of the plots, stamps or pen sets added to a set.

(@ Sub-sets
Can be created in a set by dividing multiple piots in a set into groups. The
illustration on the previous page shows an example of sub-sets: two sub-sets
“Sect 17 and “Sect 2” have been added. This is useful when, for example, one
wishes to print only the plots in Sect 2.
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5. Select a method to save the edited source plot file.

Select “Modify Source Plot File” to overwrite the original file. Note that the old
data cannot be recovered after the edited data is saved.

Select “Replace Source Plot File” to save the edited data as a new file having a
different name.

Select “Modify Raster File” to save the edited data over the raster file.
6. Click on the “OK” button.

 Madify Plot
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3.6.3 Editing a raster file

Select the source plot file of the raster file to be edited from the sets/members tree
and then “Image Editor” in the Tools menu or click on the &l in the toolbar. The image
editor is then started and a raster file image is displayed. Edit the raster file using the
image editor.

Ricoh Controller - Untitled

A raster file can also be edited by clicking on the “Edit” button in the Names tab of the
Properties (see 3.13.1 Names tab).

The edited raster file can be restored to the original one by clicking on the “RIP”
button in the Names tab of Properties.
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3.4 Creating and deleting a new set

3.4.1 Creating a new set

To create a new set, select “New” and then “Set” in the File menu or click on the £
button in the toolbar. A new set is created as a sub-set of the currently selected set.

icoh Controller ~test2 rfx

3.4.2 Changing a set name

A new set is automatically named “New Set”. To change the name, select the set in
the sets/members tree and click on the name. The new name can then be entered.

3.4.3 Deleting a set

To delete a set, select the set to be deleted and press the delete key. All members
within the set are deleted as well.
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3.5 Inserting and deleting a plot

3.5.1 Inserting a plot
An existing image file can be inserted as a plot into a set. Scanned image data can
also be inserted as a plot (see 3.12 Scanning).
Perform the following steps when inserting an image file as a plot into a set.
1. Select the set where the image is inserted from the sets/members tree.

2. Select “Image” in the Insert menu or click on the & button in the toolbar. The file
select dialog box is displayed.

o CrleAlk+. -

3. Select the file to be inserted and click on the “Open” button. Only file formats
accepted by Client can be inserted (see 10.4 Plot file formats).

utocad_drawing_1.TIF:
B Autocad_drawing 2. TIF
B Autocad_drawing_3.TIF

i) building_1.tif

centrifuge_1.tf
@ centrifuge_2.tif

3.5.2 Deleting a plot

To delete a plot, select the file to be deleted and press the delete key.
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3.6 Displaying and editing a plot
3.6.1 Displaying a plot

When a plot is selected from the sets/members tree, a thumbnail (low resolution
version) of the image is displayed on the right side of the project window. When a plot
is inserted in a set, a thumbnail is automatically created from the plot.

When displaying an image of a higher resolution plot, select the plot to be displayed
from the sets/members tree and select “image Editor” in the Tools menu or click on
the &l button in the toolbar. The image editor is started and the image of the raster
file is displayed. A raster file is a TIFF file created for printing from a source piot file
inserted in the set.

By using the Preferences tab in Options, the point at which a raster file is created can
be selected between when a plot is inserted into a set and when it is printed. It can
also be created easily by using “RIP” in the Names tab in Properties.

% Ricoh Controller - test2 sfx.
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3.6.2 Editing a source piot file

A source plot file can be edited only when a plot is not saved in a vector format.
Perform the following steps when editing a source plot file.

1. Select the source plot file to be edited from the sets/members tree.

2. Select “Modify” in the Edit menu. The Modify Plot dialog box is displayed.

R' oh Controller - test?.afx -

AlsM

3. Check the item to be converted in “Transformations”.
Select “Despeckle” to remove small speckles (see 10.2 Technical notes).
Select “Deskew” to correct a skewed image (see 10.2 Technical notes).
Select “Invert” to swap white and black.
Select “Mirror” to mirror the plot file.
Select “Scale” to enlarge/reduce an image by 25 to 400%.

4. Define the rotation angle of the image by “Rotate”.
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3.7 Inserting and deleting a stamp
3.7.1 Inserting a stamp

The stamp file created by the Stamp application can be inserted into a set or plot. A
stamp inserted into a set can be applied to all the plots in the set. A stamp inserted in
a plot can be applied to that plot only.

Perform the following steps when inserting a stamp.

1. Select the set or plot from the sets/members tree into which a stamp is to be
inserted.

2. Select “Stamp” from the Insert menu or click on the & button in the toolbar. The
file select dialog box is displayed.

& Ricoh Controller - Untitled

3. Select the stamp to be inserted and click on the “Open” button.

prrtplef

{#] costdescription. stp
[é] datetime. stp

E] filenamepath. stp
£ moddatetime. stp

3.7.2 Deleting a stamp

To delete a stamp, select the stamp to be deleted and press the delete key.
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3.8 Editing a stamp

To change the insertion point and characteristics of a stamp in a plot for printing,
select the stamp file to be changed from the sets/members tree and Properties in the
Edit menu. The Stamp tab is then displayed and the setting can be changed (see
3.13.7 Stamp tab).

Ricoh Cantroller - Untitled’

To edit a stamp, select the stamp file to be edited from the sets/members tree and
select “Stamp Editor” in the Tools menu or click on the ¥ button in the toolbar. The
Stamp application is started and the stamp can be edited (see 5 Using Stamp).
Stamp editing can also be started by clicking on the “Edit Stamp” button in the Stamp
tab.

Ricoh Controller - Untitled

3-18



Using Client

3.9 Inserting and deleting a pen set
3.9.1 Inserting a pen set

A pen set that is used when a vector plot file is rasterized can be inserted in a set or
plot. A pen set inserted in a set can be applied to all the plots in the set. The pen set
inserted in a plot can be applied only to that plot.

Pen sets can be created in the Pen Set tab (see 3.13.6 Pen Set tab).
Perform the following steps when inserting a pen set.

1. Select a set or plot from the sets/members tree into which a pen set is to be
inserted.

2. Select “Pen set” from the Insert menu or click on the £ button in the toolbar. The
file select dialog box is displayed.

Ricoh Controller - Untitled

1] default_penset pen

Et] shaip_penset.pen

@ shamp_penset2 pen

3.9.2 Deleting a pen set

To delete a pen set, select the pen set to be deleted and press the delete key.
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3.10 Changing the order of the sets/members tree

The printing order can be changed by moving members in a set.
Perform the following steps when moving a member.
1. Select the member to be moved from the sets/members tree.

2. Click on the “Up”/“Down” buttons on the project window to move the member. It
can also be moved by selecting “Move Up”/“Move Down” in the Edit menu.

A member can also be moved by drag-and-drop.

3-20



Using Client

3.11 Printing
3.11.1  Printing

Printing is performed using the rasterized data.
Perform the following steps when printing.

1. When using the setting and plotter for the previous print job, proceed to step 6.
Select “Options” from the Tools menu and then the Accounting tab.

3 Ricoh Controller - Untitle

2. Assign the cost center and user ID to record the print job information (see 3.74.1
Accounting tab).
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3. Select a set or plot to be printed from the sets/members tree.
4. Select “Print” from the File menu or click on the “Print” button on the project

oh Controlles - Until

5. Select the printer in “Destination”.
6. Set the number of copies and copying order in “Copies”.

7. Click on the “Options” button to change the option settings (see 3.14 Setting
options).

8. Click on the “Start Print” button.

3-22



Using Client

3.11.2 Print dialog box

* Destination
Used to select one of three printing destinations: a plotter, “Printer” and “E-Mail to”.
“E-Mail to” is not supported in this software version.
The plotter connected to the Local Client is displayed in the plotter box.
The plotter box is not displayed on Remote Clients.
“Printer” displays the printer driver installed in the Windows NT Printers folder.
“E-Mail t0” is selected when using a remote printer via e-mail. Enter an e-mail
address to which the print job is sent in the box. When auto-dialing to the remote
access server (RAS), type the location to be dialed in the Phone Book Entry box.

* Files
Displays the file to be printed.
* Copies
Used to set the number of copies.
When checking “Collate”, the set number of copies is printed page by page.

When checking “Reverse”, printing is performed from the last data in the sets/
members tree.

* Media
Displays the media, or paper, to be used.

Use the Media tab in Properties to define the paper to be used (see 3.73.3 Media
tab).
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3.12 Scanning

3.12.1 Scanning
Scanning is possible using a scanner. The scanned data is inserted into a set as a
plot file.
Scanning is not possible from Remote Clients.
Perform the following steps when scanning.
1. Select the set into which the scan data is inserted in the sets/members tree.

2. Select “Scan” from the File menu or click on the “Scan” button on the project
window or the &3 button in the toolbar. The scan dialog box is displayed.
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3. Select if the image data scanned by “Output File” is to be named (see 3.72.2
Scan dialog box).

4. Select the mode to be used for scanning from “Scan Mode”. Only normal mode
can be selected in this software version.

5. Set the scanning size of the original in the “Size Mode” (see 3.12.2 Scan dialog
box).

6. Select the conversion method for the scanned data from “Transformation”.

7. Click on the “Options” button to change the option settings (see 3.14 Setting
options).

8. Click on the “Start Scan” button. The scanning message is displayed.

9. Place the original to be scanned on the scanner. Multiple originals can be
scanned.

10. Scanning starts automatically.
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11. When selecting “Prompt for Filename” in step 3, the Save Scan File As dialog
box is displayed after completing scanning of each original. Enter a save location
filename and click on “Save”.
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3.12.2 Scan dialog box

* Qutput File
Used to select how to name a file required for inserting the scanned data in a set.
When “Prompt for Filename” is checked, a filename can be created by the user.
When “Generate Filename using Prefix” is checked, a filename is created
automatically using the prefix entered by a user in the edit box.

 Scan Mode
Used to select the scan mode.

* Size Mode
Used to define the size to be scanned from the original.
When “Auto Size” is checked, the scanned size is automatically set.
When “Select Width” is checked and the width is defined, only the selected width is
scanned from the original. The length is set automatically.
When “Select Size” is checked, the area to be scanned can be selected or defined.
The selected sizes are set by Admin (see 4.4 Scanner Sheet Size tab). The setting
range is from 1.00" to 36.00" in width and from 1.00" to 392.91" in length.
When scanning an original longer than 72" in length, check “Long Plot”.

* Transformation

Used to transform the data to be scanned.

A scan magnification ratio can set in “Scale”.

When “Invert” is checked, black and white data are inverted during scanning.
When “Mirror” is checked, the data is mirrored during scanning.

The scan density can be set in “Gray Scale Threshold”.
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3.13 Setting properties

To set the properties, first select the file to be set from the sets/members tree. Then

either right-click to display the pop-up menu and select “Properties” or select directly
from “Edit” in the menu bar. The Properties dialog box is displayed and settings can

be entered.

When the AutoCAD license is assigned (see 7. License Setup), the AutoCAD tab is
added to the Properties dialog box.

Properties... ‘Alt+Enter -

3.13.1 Names tab

Information about the set or plot selected from the sets/members tree is dispiayed in
this tab. A set name and plot name can be changed, the raster file can be edited and
the pre-edited raster file can be regenerated from the piot file in this tab.

¢ Set Name

Displays the selected set name or the set name containing the selected plot. The
name can be changed only when a set is selected.
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* Plot Name
Displays the selected plot name. The name can be changed.

* File Type
Displays the file format of the selected plot file.

* Plot File Name

Displays the path, owner, size, creation date and revision date of the selected plot
file.

* Raster File Name
Displays the path, owner, size, creation date and revision date of the selected raster
file.
Clicking on the “RIP” button recreates the raster file from the plot.
Clicking on the “Delete” button deletes the raster file.
Clicking on the “Edit” button starts the image editor, the image of the raster file is
displayed and editing is enabled.

* Thumbnail File Name
Displays the path, owner, size, creation date and revision date of the thumbnail file
of the selected plot.

3.13.2 Comments tab

A comment on the set or plot selected from the sets/members tree can be created
and edited in this tab.
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3.13.3 Media tab

The media, or paper, used for printing the set or plot selected from the sets/members
tree is selected and the cutting position of the paper is set in this tab.

¢ Select Media by
Two settings are provided to select the print paper.
When “Source” is checked, the roll number or paper fed from the bypass table is
selected.
When “Size/Type” is checked, the type and width of the paper to be used is
selected. The paper types available are normal paper, vellum and film. Auto select
or sizes ranging from 8.5" to 36.0" can be selected for the paper width.

e Cut Length
Two settings are provided to define the cutting position of the paper.
When “Synchro Cut” is checked, the paper is cut at the end of the printed image.
When “Synchro Cut” is not checked, the length can be defined in “Force to”. Any
value between 11.00" and 392.91" can be set. However, paper is actually cut at
200" even if more than 200" is set. Call service when printing on paper longer than
200" is required.
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3.13.4 Transformation tab

In this tab, the image of the set or plot selected from the sets/members tree is
transtormed before printing.

* Scale

Sets the print magnification ratio.

When “Auto Scale” is checked, the ratio of the image is set automatically so that the
size fits on the print paper to be used.

When “Auto Scale” is not checked, a magnification ratio can be defined in “Scale”
So that the image is printed at that ratio. The setting range is from 25 to 400%.

* Rotation
Defines the rotation angle of the image. The angle of the image can be selected
from 0, 90, 180 and 270 degrees or Automatic.
When “Automatic” is selected, the image is automatically rotated according to the
paper width. For example, when printing a 24" long 36" wide image file onto 24"
wide paper, the image is automatically rotated 90 degrees.

* Pen Settings
Assigns the pen set to be used when rasterizing a vector plot file.

* Mirror
Mirrors the image.
* Invert
Inverts the image: swaps white and black.

* Despeckie
Removes small speckies (see 10.2 Technical notes).
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3.13.5 Layouttab

This tab is used to choose the placement of the image of the selected set or plot from
the sets/members tree.

Propesties - building_§

* Position
Select the print area from one of nine (three by three) boxes to offset the image
from the top/bottom edge and left/right edge of the sheet.
When the top left area is selected, for example, use the keys in the Down box to
define the length offset from the top edge and the keys in the Right box to define the
width offset from the left edge. The setting range is 0.00" to 36.00" for top/bottom
edges and 0.00" to 36.00" for left/right edges.
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3.13.6 Pen Set tab

This tab is used to display information on the selected pen set or the pen set
contained in the selected set/plot from the sets/members tree. It is also used to
create a pen set.

* Pen Set
The Name box displays the name of the selected pen set or the pen set contained
in the selected set/plot. The name can be changed.
The File box displays the file path of the selected pen set or the pen set contained
in the selected set/plot.

 Edit Pen
Used to set line width and pattern for each pen number.
In the From and To boxes, the first and last numbers of the pen numbers to which
the same line width and pattern are to be assigned are set ranging from 1 to 256.
In the Width box, the line width of the pen numbers defined in the From and To
boxes can be set to any value from 0.0025" to 0.0750".
In the Pattern box, the line pattern of the pen numbers defined in the From and To
boxes can be set to any value from 0 to 31. See the appendix for more information
on the pen patterns.
Click on the “Apply” button to add the width and pattern selected in the From and To
boxes to the pen list.
Click on the “Remove” button to delete the width and pattern selected in the From
and To boxes from the pen list.
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 Clear Pens
Click on this item to delete all pen settings from the pen list.

* | oad Pens
Click on this item to open the file select dialog box and select the desired pen set.
The selected pen set file is read into the pen list.

* Save Pens
Click on this item to save the settings made in the Edit Pen box as a pen set file.

* Pen Set Comments
Used to create and edit a comment on the selected pen set. Up to 1000 characters

can be entered.
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3.13.7 Stamp tab

This tab is used to display information on the selected stamp or stamp contained in
the selected set/plot from the sets/members tree. The tab is also displayed when a
stamp is inserted into the set/plot.

e Stamp
The Name box displays the name of the selected stamp or the stamp in the
selected set/plot. The name can be changed.
The Type box displays the file format of the stamp.
The File box displays the path of the selected stamp or the stamp in the selected
set/plot.
The "Browse” button is used when inserting a stamp or when replacing the selected
stamp or a stamp in the selected set/plot with another one. Clicking on the “Browse”
button displays the file select dialog box, in which the stamp file can be selected.

* Rotation
The angle at which the stamp is inserted into a plot can be selected between 0 and
360 degrees.

¢ Scale

The magnification ratio of the stamp to the plot can be setin a range from 25 to
2000%.
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* Transparent

When this item is checked, the degree to which the image can be seen through the
inserted stamp can be set in the Level field to any value from 0.0 to 100.0%. When
set to 0.0%, the plot image is completely invisible; when set to 100.0%, the plot
image is completely visible.

* Border
When this item is checked, a border is drawn around the stamp.

¢ Comment

A stamp comment can be created and edited. Up to 1000 characters can be
entered.

* Stamp Placement
One of nine (three by three) areas can be selected as the base insertion point of the
stamp. An offset within the box can then be entered.
When the top left area is selected, for example, use the keys in the Down box to
define the insertion point relative to the top edge and the keys in the Right box to
define the insertion point relative to the left edge. The setting range is —36.00" to
36.00" for the top and bottom edges and —36.00" to 36.00" for the left and right
edges.

* Edit Stamp
Click on this item to edit the selected stamp.
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3.13.8 AutoCAD tab

This tab is used to set the properties of an AutoCAD file.
To use AutoCAD files, the license setting must be performed (see 7. License Setup).

* Autocad File Type
Displays the AutoCAD file format.
The file formats available on this software version are DWG and DXF.
¢ Unit Scale Factor
Sets the magnification for rasterizing an AutoCAD file.
By default, the magnification is set so that the image width will be 36" (A0 size). The
following formula is applied:
[Image width set in AutoCAD file (inch)] x[Unit Scale Factor (default)] = 36 (inch).
¢ Plot Units
Sets the units system for Unit Scale Factor.

* Print full Extent
Select this item to print the whole range of an AutoCAD file.
¢ Print View

To print a view set in the AutoCAD file only, select this item and then the view to be
printed from the drop-down list box.
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3.14.5 AutoCAD tab

This tab is used when setting options for an AutoCAD file.

* ASCII (8 bit) Font

If the folder defined in the Font Path box in the AutoCAD tab in the Properties dialog
box does not contain the ASCII code font file used in an AutoCAD file, the font file
defined in this box will be used instead.

* UNICODE (16 bit) font

If the folder defined in the Font Path box in the AutoCAD tab in the Properties dialog
box does not contain the UNICODE code font file used in an AutoCAD file, the font
file defined in this box will be used instead.
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3.14.4 Scanner tab

Selects the scanner and displays information about the selected scanner.

* Scanner Type
Displays the model name of the scanner.

* Device Driver
Displays the driver name of the scanner.
* Resolution (DPI)
Displays the scanning resolution.
* Manual Sizing
Indicates whether the size to be scanned is set.
* Size Detection
Indicates whether to detect the paper size (width and length) automatically.
* Length Detection
Indicates whether to detect the paper length automatically.

* Scan Modes
Displays the list of modes used for scanning.
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3.14.3 Local Plotter/Network Plotter tab

This tab displays information about the selected plotter. The Local Plotter tab is not
displayed on Remote Clients.

e Name

In the Local Plotter tab, the connected plotter is displayed.
In the Network Plotter tab, the printer driver installed in the Windows NT Printers
folder is displayed.

* Type
The model name of the plotter is displayed.
¢ Device Driver
Displays the driver name of the plotter.
* Resolution (DPI)
Displays the print resolution.
e Manual Feed
Indicates whether paper feed is available.

* Media Detection
Indicates whether to detect the paper type automatically.

* Width Detection
Indicates whether to detect the paper width automatically.

* Print Media
Displays information about the types and widths of the available media.
“Cut” is displayed when the plotter supports auto paper cutting. When this button is
clicked, the media is cut automatically by the plotter.
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3.14.2 Preferences tab

This tab is used in the settings for the Client application.

* Units
The Measurements box defines the units used for image size.
The Pen Width box defines the units used for the pen width in the Pen Set tab.

¢ File Rasterization
Sets the point at which a piot is rasterized.
When “RIP immediately and save” is selected, a piot is rasterized when inserted in
the set.
When “RIP when printed” is selected, a plot is rasterized when printed.
* Prompt on Interrupt
Displays a message confirming any interruption of printing or scanning.

* Disable Accounting
Assigns no records in the account database.

e TIFF Compression
Selects the compression format of TIFF files for creating a raster file from a plot file
(see 3.6.71 Displaying a plof).
The available compression formats are CCITT4, CCITT3, LZW and RLE.

¢ Image Editor Command Line

Displays the image editor used to edit raster files.
Click on the “Browse” button to define the image editor to be used.
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* User ID
Used when recording the print/scan job information of plots.

¢ Accounting Database

Displays the path of an accounting database file.
Click on the “Browse” button to define the path.

* For E-Mail Messages (Not supported in this software version.)
Sets identification information used when sending remote print jobs via e-mail.
Enter the company name to which a user belongs in the Company Name box.
Enter the user name in the Contact Name box.
Enter the user account number in the Account Number box.
Enter the phone number in the Phone Number box.
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* Font Path

Used to define the path(s) of the font folder(s) used to read in the text data in an
AutoCAD file.
To specity two or more paths, insert a semicolon (;) between paths.

¢ External Reference Path

Used to specify the path(s) of the folder(s) containing the external reference file(s)
used when reading an external reference file(s) into an AutoCAD file.

To specify two or more paths, insert a semicolon (;) between paths.

* Test Paths
Click on this button to search the fonts and external reference files used by
AutoCAD in the folders defined in the Font Path and External Reference Path
boxes. The names of the fonts and external reference files that could not be found
will be shown in the Missing Font Files and Missing External Reference Files boxes.

* Missing Font Files
Displays the names of the fonts that were used in an AutoCAD file but could not be
found in the folder defined in the Font Path box.
In this case, an alternative font defined in the AutoCAD tab in the Options dialog
box will be used.

» Missing External Reference Files

Displays the names of the external reference files that were used in an AutoCAD file
but could not be found in the folder defined in the External Reference Path box.
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3.15 Default settings
Enter the default data for the plot, stamp and pen set properties in the Default
Settings dialog box to insert them into a set.

To set the default data, select Default Settings from the Tools menu. The Default
Settings dialog box opens and settings can be entered.

Ricoh Controller - Untitled

It Settings... Alt+D

The Default Settings dialog box is almost same as the Properties dialog box: the
difference is only that it does not have a Names tab or Comments tab.

If the license is assigned (see 7. License Setup), the AutoCAD tab is displayed in the
Default Settings dialog box.

See 3.13 Setting properties for the description of each tab.
See 7.3 Default Settings for the description of the AutoCAD tab.
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This section describes how to use Admin.

4.1
4.2
4.3
4.4
4.5
4.6
4.7
4.8
4.9

Starting and closing the application
Cost Center tab

Report tab

Scanner Sheet Size tab

About Box Edit tab

Device Data tab

Printer tab

Scanner tab

Licenses tab
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4. Using Admin

The Admin application allows device settings to be configured and system usage
status reports to be viewed. There are seven tabs in the Administrator window. This
chapter describes how to use each of these tabs.

4.1 Starting and closing the application
4.1.1 Starting the application

Perform the following steps to start the application.
1. Click on “Start” in the task bar to open the start menu.
2. Select “Programs” and then “Ricoh Controller”.
3. Click on “Admin”.
The application starts and the Administrator window appears.

% Progiams

& Ricoh Contioler
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4.1.2 About the Administrator window

This section describes the Administrator window which appears when the application
starts.

(® Menu bar. Used when closing the Admin application, changing the units system
used in Admin or viewing Help.

(2 Status bar. Displays information about the menu item indicated by the mouse.
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4.1.3 Selecting the units system

Perform the following steps to select the units system.
1. Click on “Edit” in the menu bar to open the Edit menu.
2. Click on “Preferences”.

Untitled - Ricoh Admi
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4.1.4 Closing the application

Perform the following steps to close the application.
1. Click on “File” in the menu bar to open the File menu.
2. Click on “Exit”.

{i Untitled - Ricoh Admin
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4.2 Cost Center tab

The Cost Center tab displays a list of cost center information. This tab also allows
cost centers to be added, edited or deleted.

Cost centers are used to record the usage status of plotter/scanner devices. The cost
center to be used for recording is specified from the Client application. Only the cost
centers defined under the Cost Center tab will be available for selection in the Client
application.




Using Admin

4.2.1 Adding a cost center

To add a new cost center, click on the “Add” button. This displays the Cost Center
dialog box. Enter in the dialog box the name and description of the cost center, then
click on the “OK” button. A cost center name must have 20 characters or less and a
caost center description must have 80 characters or less.

4.2.2 Editing a cost center

Select the cost center to be edited from the list of cost centers and click on the “Edit”
button. The Cost Center dialog box is displayed. Edit the cost center and click on the
“OK” button.

4.2.3 Deleting a cost center

Select the cost center to be deleted from the list of cost centers and click on the
“Delete” button.
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4.3 Report tab

The Report tab displays a report on the selected plotter device, cost center and user-
ID. Atext editor is used to display the report.

* Plotter Device
Select the plotter device whose usage status is to be reported.

» Cost Center
Select the cost center whose usage status record is to be reported. Cost centers

available for selection are defined under the Cost Center tab.

* User-ID
Select the user-ID whose usage status is to be reported. User-IDs available for
selection are defined under the Accounting tab in the Options menu of the Client

application.
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* Plot Count
The number of print jobs in the database record. The database records the number
of print jobs executed during the period defined by Database Parameters.

* Report Type
Select on of three types.

* Date Range
Define the period to be covered by the system usage status report within the period
defined by Database Parameters.
Click on the “Start Date” button to enter the starting date.
Click on the “End Date” button to enter the end date.

* Report Viewer

The text editor program to be used for viewing the report. The text editor can be
selected by clicking on the “Browse” button.

* Database Parameters
Clicking on this button displays the Database Parameters dialog box. Specify the
directory containing the database to record report information and the period for
which it is retained. The directory containing the database can be specified by
clicking on the “Browse” button. The retaining period may be 30 days, 60 days, 120
days, 6 months, 12 months or indefinite. The record is automatically purged after
this period.

¢ Run Report

Clicking on this button starts the designated text editor program and displays the
report.
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4.4 Scanner Sheet Size tab

This tab displays information on the available scanning area size options (called
“scanner sheet sizes”). This tab also allows scanner sheet sizes to be added, edited

or deleted.

The sheet names defined under this tab are used in the Scan dialog of the Client
application.

* Sheet Name
The sheet name that identifies the scanner sheet size.

* Width

The width of the scanner sheet size.
¢ Height

The height of the scanner sheet size.
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4.4.1 Adding a scanner sheet size

To add a new scanner sheet size, click on “Add Sheet Size”. The Scanner Sheet Size
dialog box appears. Define the scanner sheet name and scanner sheet size
parameters, then click on “OK”.

* A Sheet Name may have up to 25 characters.
» X (width) may be set to any value between 1.00" and 36.00".
* Y (height) may be set to any value between 1.00" and 392.91".

4.4.2 Editing a scanner sheet size
Select the scanner sheet size to be edited from the scanner sheet size list and click

on “Edit Sheet Size”. The Edit Sheet Size dialog box appears. Edit in the dialog box,
then click on “OK”.

4.4.3 Deleting a scanner sheet size

Select the scanner sheet size to be deleted from the scanner sheet size list and click
on “Delete Sheet Size”.
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4.5 About Box Edit tab

This tab allows creation and editing of the text displayed when “About” is selected
from the Help menu of the Admin, Client or Stamp applications.

The text created or edited under this tab is saved in the database by clicking on the
“Save About Box Info” button.
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4.6 Device Data tab

The Device Data tab displays information about the plotter/scanner devices used with
Repro System. It also allows devices to be edited.

3 Ricoh Type 70300

* Device ID
Displays the Device IDs to identify the devices. These IDs are also displayed under
the Printer tab and Scanner tab.

* Device Name
Displays the model names of the devices.

* OpMode
Indicates whether a device is to be used only as a printer, only as a scanner or as
both. The code “1” means it is used only as a printer, “2” means only as a scanner
and “3” means it is used both as a printer and scanner.

* Enabled
Indicates whether the device is available for use by Client. The code “1” means it is
available (enabled) and “0” means not available (disabled).

* Controller

Indicates whether an interface card is used. The code “1” means an interface card
is used and “0” means not used.
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4.6.1 Editing a device

Select the device to be edited from the device list and click on the “Edit Device”
button. The Device dialog box appears. Edit the device in the box, then click on the
“OK” button_

The Name and Enabled boxes are available in this software version. In other
versions, they are unavailable and displayed only.

» A Device ID may be set to 6, 7 or 8.

* A Name may have up to 20 characters.

* Select a Device Mode from the drop-down list box.
= Check “Enabled” when using the device from Client.
* Check “Controller” if an interface card is used.
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4.7 Printer tab

The Printer tab displays a list of printers and printer modes.

Printers

* Device ID
Lists the device IDs of all devices that have been defined as printers. The Device
IDs displayed here are the same as the Device IDs defined under the Device Data
tab.

* Resolution
Shows the printer resolution in dots per inch (dpi).

* Drawers

Shows how many paper drawers each printer has.
* Print Settings

Shows print density.
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* Manual Feed
Shows if manual feed is enabled; “1” when enabled or “0” when disabied.

* Detects Media
Shows if automatic paper type detection is enabled; “1” when enabled or “0” when
disabled.

* Detects Width
Shows if automatic paper width detection is enabled; “1” when enabled or “0” when
disabled.

¢ Auto Rollover
Shows whether the printer automatically switches over to a new paper roll when it
has run out of paper. Shows “1” when Auto Rollover is enabled or “0” when
disabled.

* Min Scale Factor
Shows the minimum scale factor available for printing.

* Max Scale Factor
Shows the maximum scale factor available for printing.

* Drivers
Shows the name of the driver used for the printer interface card.

Printer Modes

* Device ID
Lists the device IDs of the printers.

* Mode Name
A name representing the printer operation mode.

* Mode ID
An ID that identifies the printer mode.
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4.8 Scanner tab

The Scanner tab displays a list of scanners and scanner modes.

Scanners

e Device ID
Lists the device IDs of all devices that have been defined as a scanner. The Device
ID displayed here is the same as the Device ID defined under the Device Data tab.

* Resolution
Shows the scanning resolution in dots per inch (dpi).

¢ Scan Settings
Shows scanning density.

* Auto Length/Width
Indicates if the automatic detection of scanning area length/width is enabied; “1”
when enabled or “0” when disabled.
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* Specify Width
Indicates if the width of the scanning area can be specified from the Client
application; “1” when it is enabled or “0” when disabled.
* Fixed Sizes
Indicates if the size of the scanning area can be specified from the Client
application; “1” when it is enabled or “0” when disabled.
* Auto Exposure
Indicates if automatic exposure is enabled; “1” when enabled or “0” when disabled.
¢ Min Scale Factor
Shows the minimum scale factor available for scanning.
* Max Scale Factor
Shows the maximum scale factor available for scanning.
¢ Drivers
Shows the name of the driver used for the scanner interface card.

Scan Modes
* Device ID
Lists the device IDs of the scannres.
* Mode Name
A name representing the scanning operation mode.

* Mode ID
An ID that identifies the scanning mode.
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4.9 Licenses tab

The Licenses tab is used to assign the license to Clients. This tab is displayed on the
Local Client only.

;52 Unhtled - Hicoh Admin

¢ Client

Displays the computer names of the Local Client and Remote Clients.
¢ AutoCAD

Check this item to assign the AutoCAD file license.

* Total Available

Displays total number of Clients that can be assigned the license.

* Total Used

Scrolls the list up and down one page at a time.
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4.9.1 Assigning the license

To newly assign the license to a Client, click on the “Add” button. A line becomes
unshaded enabling entry. Enter the computer name of the Remote Client to which the
license is newly assigned and check the check box. Click on the “Apply” button (see
7.2 Assigning the license).

Use the computer name set by selecting “Control Panel”, “Network”, “Identification”
and then “Computer Name”.

49.2 Removing the license

Remove the check mark from the check box. Alternatively, select the Remote Client
to be deleted from the Client list and click on the “Delete” button. Note that the
computer name of the Remote Client is also deleted from the Client list by the latter
method.
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This section describes how to use Stamp.

5.1
5.2
5.3
54

Starting and closing the application
Creating and saving a stamp
Editing a stamp

Checking the stamp
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5. Using Stamp

5.1 Starting and closing the application

5.1.1 Starting the application

Perform the following steps to start the application.
1. Click on “Start” in the task bar to open the Start menu.
2. Select “Programs” and then “Ricoh Controller”.
3. Click on “Stamp”.
The application starts and the Text Stamp Editor window appears.

% Programs

& Ricoh Contoler
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5.1.2 Text Stamp Editor window

The Text Stamp Editor window is described in this section.

®

@

S

©

!

() Menu bar.

(@ Toolbar.

(® Font selection bar.

(@ Edit Text box.

(® Insert Parameters box.

(& Preview box.

(@ Sets the rotation angle of a character.

Sets the rotation angle of the entire text.

(® Comment box.

Status bar. Displays information about the menu item indicated by the mouse.
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5.1.3 Closing the application

Perform the following steps to close the application.
1. Click on “File” in the menu bar to open the File menu.
2. Click on “Exit”.
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5.2 Creating and saving a stamp
5.2.1 Creating a new stamp

When Stamp is started, it creates a new stamp called “Untitled”.
A new stamp can also be created by either of the following methods:
* Click on “New” from “File” in the menu bar.
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5.2.2 Saving a stamp

1. Click on “Save” from “File” in the menu bar or the & button in the toolbar.

2. Specify the directory, enter the filename and then click on the “Save” button. A
stamp is saved as a stamp file with the “.stp” extension.

ave the active documentiSave

i costdescription. stp
‘gj datetime. stp

;;I;] flenamepath. stp
:} moddatetime. stp
J pageof.stp
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5.2.3 Opening an existing stamp

2. Select the stamp to be opened and click on the “Open” button. The Text Stamp
Editor window appears.

| costdescription. stp
@ datetime. stp

18] filenamepath. stp
@ moddatetime. stp

E‘] pageol.stp

Stamp (*.stp)

amp Editor - datetime. st,
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5.3 Editing a stamp

5.3.1 Editing text

Type or edit the text in the Edit Text box to insert it as a stamp. Click the mouse at the
desired position and type the text.

Right clicking in the Edit Text box shows the edit menu enabling cutting, pasting or
copying of the text.

When parameters are inserted into a stamp, the Edit Text box shows “$xxxx”. The
character string indicating the parameter cannot be edited.
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5.3.2 Inserting a parameter

Click on the desired parameter in the drop-down list box of the Insert Parameters box
and then click on the “Insert Parameters” button. The parameters listed in Table 5-1
can be inserted.

Parameters are inserted at the cursor location in the Edit Text box.

Table 5-1 Types of parameters

Parameter Description
$ModificationDate The date when the file was modified
SModificationTime The time when the file was modified
$CurrentDate The date when the plot file was printed
$CurrentTime The time when the plot file was printed
$Filename The name of the original file
$FilePathName The name of the file path
$MemberName The member name of the file
$CostCenter A cost center that records printing and

scanning jobs

$Description The description of the Cost Center
$SheetNumber Printing order for continuous printing
$TotalSheetNumber | Total number of sheets in continuous printing
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5.3.3 Changing the font

Change the font in the font selection bar.

> G

(1) Font selection drop-down list box
The fonts registered in the computer are available.
(2 Font size drop-down list box

The font size can be selected from the fixed sizes (between 8 and 72 points) or
specified by typing a number (between 1 and 1638 points).

9.3.4 Changing the letter style

Change the style by using “Format” in the menu bar or the buttons on the font
selection bar.

Bold
Boldfaces the text.

Italic
Italicizes the text.

Underline
Underlines the text.

Align Left
Centered

Align Right




Using Stamp

5.3.5 Rotation

Character rotation

Rotates a character to the specified angle. The character can be rotated
anticlockwise to any angle between 0 and 360 degrees. Specify the angle by clicking
on A or ¥ or typing a number.

Base rotation

Rotates the entire text to the specified angle. The line can be rotated anticlockwise to
any angle between 0 and 360 degrees pivoting around the top left corner of the text.
Specify the angle by clicking on A or ¥ or typing a number,
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5.4 Checking the stamp

Check the printing status of the edited stamp in the Preview box.
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This section describes plotter setting for network use.

6.1
6.2
6.3
6.4

Setting the Remote Client

Setting the Local Client

Checking Remote Client operation
Returning to local mode
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6. Network Plotting

In this section, for convenience the Client application running on the Local Client is
called the Local Client application and the Client application running on a Remote
Client the Remote Client application.

The Local Client application operates in two modes: local mode and network mode.

In local mode, the Local Client can use the connected plotter/scanner to both print
and scan. In network mode, the Local Client serves as a plotter server to receive print
jobs from other network Clients, namely Remote Clients, and prints them on the
connected plotter.

In the network mode, the Local Client application provides plotter server facilities
only.

Even though the Local Client application is closed in the network mode, it still serves
as a plotter server. However, no Print Problem messages (indicating print errors) are
displayed. When a print error occurs, restart the Client application and then solve the
problem.

For information on how to operate on the Remote Client, see 3. Using Client, 4.
Using Admin and 5. Using Stamp.
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6.1 Setting the Remote Client

6.1.1 Installing the Repro System

Install the Repro System on a Remote Client as follows:

1.

Start Windows NT and close any unnecessary applications.

2. Insert the supplied CD-ROM into the CD-ROM drive.
3. The Setup screen appears followed by the Welcome screen. Click on the “Next”

button.

. The Choose Destination Location screen appears.

Click on the “Next” button.

. The Setup Type screen appears.

Select “Client Software” and click on the “Next” button.

. The Select Components screen appears.

Select all the components for normal operation and click on the “Next” button.

. The Select Program Folder screen appears.

Click on the “Next” button.
The program group name can be changed to another name if so desired.

. The Start Copying Files screen appears.

Click on the “Next” button.

- The Setup Complete screen appears after installation is complete.

Remove the CD-ROM from the CD-ROM drive and click on the “Finish” button to
automatically restart the computer.

The installation program creates a program item in the Start menu. The program
group name is “Repro System”. It contains three program items, called Client, Admin
and Stamp.

On uninstalling the Repro System, files in the C:\Program Files\Repro System
directory may be deleted. Move any image files before uninstalling the Repro
System.
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6.1.2 Setting the printer

To use the plotter on the network at a Remote Client, printer configuration must be
performed.
Configure the printer as follows:

1. Click “Start” in the task bar to open the Start menu.

2. Click “Printers” in “Settings”.

[ WindowsNT

3. Double-click “Add Printer”.

[0}
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4. Select “Network printer server” and click “Next”.

5. The Connect to Printer dialog box opens. Select the plotter connected to the
server and click “OK”.

¥4 Microsolt Windows Network
fg HOTLINE

" Type 703D

6-5



Network Plotting

6. Select whether to configure the plotter as the default printer and click “Next”.

7. Click “Finish”.

Add Printer Wizard

s

Add Printer Type FO30D
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6.2 Setting the Local Client
To use the Local Client as the plotter server, the Local Client must be in the network
mode.
To enter network mode, perform the following steps.
1. Start the Local Client application.

2. Select “Network” from the Mode menu or click on the 5 button. The network
mode dialog is displayed at the right of the project window.
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6.3 Checking Remote Client operation

Check for correct communication between a Remote Client and the plotter server by
performing the following steps after making the Remote Client and Local Client
settings.

1. Start Windows NT.
2. Open the Start menu by clicking on “Start” in the task bar.
3. Select “Programs” and “Ricoh Controller”.

4. Click on “Client”. The Remote Client application starts and the project window
appears.

Programs

B2 Ricoh Conrller
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5. Select “Network System Status” in the View menu.

Ricoh Contraller - Untitled

Network System Status

6. The Network System Status screen appears. If communication is good, the
“Status-OK” message is displayed at the top right of the screen.

lwork Syle tal )

7. Click on the “Close” button to close the screen.

If the “Status-OK” message is not displayed in the Network System Status screen,
check whether the designated printer and the plotter server are configured correctly
(see 2.4 Checking operation).
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6.4 Returning to local mode
In network mode, the Local Client application only provides plotter server facilities. In
order to use other Client facilities, it is necessary to return to local mode.

There are three ways to return to local mode:

“Immediately”™ Click on this button to return to local mode, even in the middle of the
current plot.

“After Current Plot”. Click on this button to return to local mode after the current plot.
Even if there are other plots remaining in the print job, only the current plot will be
printed.

“After Current Job™: Click on this button to return to local mode after the current job.
All the plots in the print job will be printed.
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7 = License Setup

This section describes how to set the license requirad to use
AuteCAD files.

7.1 Installing the license
7.2 Assigning the license
7.3 Default settings
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7. License Setup

7.1 Installing the license

To use AutoCAD files, the license must be installed on the Local Client.
Perform the following steps to install the license.

1. Connect the dongle to the parallel port on the Local Client. Do not connect more
than one dongle.

Paraliel port

Dongle

2. Restart the computer.

3. Start the Client application. Select “About Repro System” from the Help menu.
The About Repro System dialog box is displayed.

4. In the Licenses Available box in the About Repro System dialog box, check that
the license is installed.

About Aicoh Controller - Local Client

7-2



License Setup

7.2 Assigning the license

To use AutoCAD files, the license installed on the Local Client must be assigned to
the Local Client or Remote Clients.

Perform the following steps to assign the license to Clients.

1. Start the Admin application on the Local Client and select the Licenses tab. The
computer name of the Local Client is displayed in the Client box.

2. Click on the “Add” button. A line becomes unshaded enabling entry.

3. Enter the computer name of the Remote Client to which the license is to be
assigned in the Client box.
Use the computer name set by selecting “Control Panel”, “Network”,
“Identification” and then “Computer Name”.
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8 = Troubleshooting

Thiz section describes troubleshooting procedures.

8.1 Troubleshooting
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8. Troubleshooting

8.1 Troubleshooting

|
l Trouble Check procedure/corrective measures Ref:;‘ggce
The Repro System Check if the copier power is turned on.
cannot be operated. Check if the copier is offline. If it is, reset 2-5
it.
Check if the on-line indicator of the copier 2-7
is on. If not, turn it on by pressing the on-
line key.
Check if the machines are connected 2-3
correctly.
' The copier cannot be Check if the on-line indicator of the copier
jcontrolled via the copier | is on. If it is, turn it off by pressing the on-
‘operation panel. line key.
Printing from the Repro | If the Print Problems dialog box is dis- 2-7
System is disabled. played, follow the instructions to remove
the cause.
Check if the Windows NT network is con-
figured correctly.
- Tail of the scanned Check “Long Plot” when scanning origi- 3-27

1

\image is not printed.

nals 72" or longer.
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9 = Specifications

This section describes the specifications of the Repro System.

9.1
9.2
9.3
9.4

Basic specifications
Hardware specifications
Software specifications
Interface specifications
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9. Specifications

9.1 Basic specifications

ltem

Specifications

Remarks

Product name

Repro System

Functions

Rasterizes and prints the image file
(plot file) specified in Client.

Attachment method

By connecting the PCI controller
interface card in the computer and
the video terminal on the relay PCB
in the copier with the interface cable.

The relay PCB
shall be
installed by a
serviceperson.

System Model IBM PC/AT compatible and PCI
requirements controller interface card
CPU Pentium Pro 200 MHz or faster
Memory 128 MB
Hard disk 2 GB or more
oS Windows NT 4.0 and Service Pack 3
Applications CAD/graphics software that can License setting
store files in HPGL, HPGL/2, TIFF, |is required to
Calcomp, BMP, WMF, DWG and use DWG or
DXF formats is required to create | DXF format on
plot files. Repro System.
Image Scanner input | Width: 1.00" — 36.00"
processing Length: 1.00" — 392.91"
size

Printer output

Width: 1.00" — 36.00"
Length: 1.00" — 392.91"
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Item Specifications Remarks
Resolution Scanning 400 % 400 dpi
Printing 400 x 400 dpi
File formats | Source plot file |HPGL, HPGL/2, TIFF, Calcomp, ~ |-icense setting

BMP, WMF, DWG and DXF

is required to
use DWG or
DXF format on
Repro System.

Raster file TIFF
System units Inches, feet, mm, cm and mare  Client: Specified
available. in the Preferen-
Setting values are converted to the [°€S tab _
corresponding values in other units {dmin: Speci-
based on the inch sizes. fied by _
“Preferences” in
the menu bar
Application Client Core application containing plot file
configurations print setting and scan functions.
Admin An application that registers and
edits the values set by Client and
administers the printing and
scanning job history.
Stamp An application that creates stamp
files that can be inserted into plot
files.
Server An application that controls the Installed on the
plotter/scanner. Local Client
only
Operating Temperature | 10°C/50°F — 35°C/95°F
environment
Humidity 15 - 85%RH
lllumination Less than 3000 lux
intensity

9-3



Specifications

9.2 Hardware specifications

Item Specifications Remarks
PCI controller interface card | PCl card
Rated Voltage SVDCzx5%
Current Less than 0.85 A
Power Depends on the computer power
consumption | source.
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9.3 Software specifications

9.3.1 Printing

Item

Specifications

Remarks

Printable file formats

TIFF, HPGL, HPGL/2, Calcomp,
BMP, WMF, DWG and DXF

License setting
is required to
use DWG or
DXF format on
Repro System.

Sizes

Width: 1.00" — 36.00"
Length: 1.00" — 392.91"

Printing quantity

1-99

Printing order

Sorting order and reverse order
available

Printing magnifications

25 — 400%

Paper source setting

Without optional drawer: 2 drawers
and bypass

With optional drawer: 3 drawers
and bypass

Paper, vellum and film

Available

Selected between 9 areas (3 long x
3 wide)

Oftset from leading or trailing edge:
0.00" - 36.00"

Media type
Automatic roll exchange
Printing Reference
position
Longitudinal
direction
Lateral
direction

Offset from right or left edge:
0.00" - 36.00"
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9.3.2 Scanning (Local Client only)

ltem Specifications Remarks
Sizes Width: 1.00" - 36.00"
Length: 1.00" - 392.91"
Length specification Set when using originals 72" or
longer
Scanning density 13 steps
Continuous scanning Available Not available
when specity-
ing the names
of scan files.
Scanning magnifications 25 — 400%

Mirror Setting available

Invert Setting available

Rotation 0°, 90°, 180° and 270°

Image display Thumbnail view after scanning

Data saving format

TIFF
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9.3.3 Stamping

Item Specifications Remarks
Stamping angle 0° -~ 360°
Stamping magnification 25 — 2000%
Transparency 0 - 100% (0.1% increments)
Border line Setting available
Stamping Reference Selected between 9 areas (3 long x
position 3 wide)
Longitudinal | Offset from the leading or trailing
direction edge: —-36.00" — +36.00"
Lateral Offset from the right or left edge:
direction -36.00" - +36.00"
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9.4 Interface specifications

Item

Specifications

Remarks

PCI controller interface card

Installed in a PCI slot of a computer

Video terminal

Installed on the back of the copier
by connecting the internal copier
relay cable to the relay PCB

The relay PCB
and internal
copier relay
cable shall be
installed by a
serviceperson.

Interface cable

118", shielded

Interface cable connector

Interface card: Video 80-pin
Copier: Video 100-pin

9-8




1 0- Appendices

Useful information is listed in this section.

10.1  The LittleBear driver
10.2 Technical notes

10.3 Pen patterns

10.4  Plot file formats
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10. Appendices

10.1 The LittleBear driver

The Repro System is designed to communicate with the copier through an interface
card. This card is designed specially for communication with digital copiers.

When using the Windows NT operating system to communicate with a copier through
an interface card, a device driver application (the LittleBear driver) must be loaded
onto the computer beforehand. This device driver works as the mediator between the
higher level software (Repro System) and the hardware (interface card). The Repro
System never talks directly to the interface card. All signals are relayed through the
LittleBear driver running as part of the operating system.

The LittleBear driver (LittleBear.sys) should be installed in the WinNT\System32\drivers
directory. The LittleBear driver is automatically installed by the installation program.

To check if the LittieBear driver is running, select “Devices” from the Windows NT
control panel.
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10.2 Technical notes

Deskew

The Deskew function used in the Modify Plot screen automatically corrects skewed
plot images. There is no need to tag two points along a line on an image: the deskew
function automatically detects the angle of the document and rotates it so that it is
straight. An image can be deskewed more than once.

For more control over deskewing an image, any suitable third-party raster editor may
be used.

Despeckie

The Despeckle function used in the Modify Plot and Properties screens is used to
help reduce noise in 1-bit images. Single pixels and pixel spurs on letters and
graphics are removed while leaving the solid areas intact. The despeckle operation
performs a 3 x 3 median filter on the image. For each 3 x 3 neighborhood of pixels in
the original image, a singie pixel is produced in the output image. In this case the
output is the median of the 9 values in the 3 x 3 neighborhood.

Selecting Despeckle in the Modify Plot screen causes the Repro System to replace
the original file with the despeckled version of the file. An image can be despeckled
more than once.

Selecting Despeckle in the Properties screen causes the Repro System to generate
a temporary despeckled copy of the image and the temporary copy is printed during
the current print job. The original image is not replaced.

For more control over despeckling an image, any suitable third-party raster editor
may be used.
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10.3 Pen patterns

Figure 10-1 shows the pen patterns that are used by the Repro System when
rasterizing HPGL/2 plot files. The patterns are defined in the patterns.dat file as
16 x 16 pixel blocks. The pattern file can be modified to add additional patterns.

In general, patterns 0 through 15 are designed to be used for line work. Patterns 16
through 29 are designed for filled areas. Patterns 30 and 31 are special dotted line
patterns.

The lines shown in this manual may not accurately represent what the Repro System
will produce on a copier.
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Figure 10-1 Pen patterns
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10.4 Plot file formats

The following is a list of file formats accepted for plotting by the Repro System.
Only monochrome images (1 bit per pixel) can be printed.

BMP (BMP)

Calcomp

HPGL (HP, HPGL, PLT)
HPGL/2 (HP, HPGL, PLT)
TIFF (TIF)

Windows Metafile (WMF)
AutoCAD (DWG, DXF)
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WARNING

This equipment has been tested and found to comply with the limits for a Class A
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can
radiate radio frequency energy and, if not installed and used in accordance with the
instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful
interference in which case the user will be required to correct the interference at his
own expense.

CAUTION - The changes or modifications not expressly approved by the party
responsible for compliance could void the user’s authority to operate the equipment.

*The above warning is valid only in the United States of America.

WARNING

This device complies with Part 15 of the FCC Rules. Operation is subject to
the following two conditions: (1) This device may not cause harmful
interference, and (2) this device must accept any interference received,
including interference that may cause undesired operation.

*The above warning is valid only in the United States of America.

This Class A digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe A est conforme 2 la norme NMB-003 du
Canada.

DO NOT touch electrical parts, such as connectors or printed circuit boards. They
could be damaged by static electricity.
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